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Please ensure you follow every step in order.

If your system does not comply with this list, DO NOT continue the install!

Overview of the Installation

System Requirements

Optimal Requirement (CPU, Memory, HHD and SO)
o Processor: i7 3.5GHz 4770K or better

Hard Drive: SSDs with 500MBs or greater

Memory: 12 GB DDR3 1666MHz or greater.

Motherboard: x79 Chip

Windows 7 pro and Windows 8 64 bit only

O O O O

Minimum Requirement for software WITHOUT variable data (CPU, Memory, HHD and SO)
o Processor: Intel i5
o Hard Drive: 7200 RPM
o Memory: 8 GB
o  Windows 7 Pro and Windows 8 64 bit only

Power 120v and 220v
o Minimum outlets (5)

Network
o (2) IP Addresses for the Feeder and Printer
o (3) Network Cables

Before starting the software installation, you need to ensure that you have a clean
version of Windows 7 with nothing installed. In order to do so, you will need to make sure
of the following:

O
O
O

There are no applications installed or currently running.

There are no antivirus programs installed.

The computer you're planning to install the software on has the printer and
feeder on the same network.

Ensure your user account has Administrator privileges on the local
computer.



1.1 Safety Information

Your UniNet product has been carefully designed to give you years of safe, reliable performance. As with all electrical
equipment, there are a few basic precautions you should take to avoid hurting yourself or damaging the product.

Warning - Here are some of the things to look for:

Save all provided documentation for future reference. Ensure all warning and instruction labels on the product are
read, understood and followed in order to prevent any risk of injury.

This product may be heavy. Please check the weight of the product and take all necessary precautions to prevent
the risk of personal injury. Place your product on a firm, solid surface. If placed on something unsteady, it may fall
and be damaged. If placed on a soft surface, the vents may be blocked, causing the product to overheat.

If the product is installed on a cabinet or high capacity feeder, ensure wheel locks are applied once placed in final
position for use, to prevent risk of movement or injury.

Protect your product from overheating. Make sure no obstructions block the openings of the product. Do not put the
product on or near a heat source (such as a radiator or heat register). Keep the product out of direct sunlight. Allow
enough room around the product for adequate ventilation and easy access to the paper paths. If the product is
placed in any kind of enclosure, make sure the enclosure is well ventilated to prevent a fire.

When the product cover is open, do not touch the fuser unit or print head as you may receive burns. Allow it to cool
before touching.

If the product casing gets extremely hot or smoke, unusual smells or abnormal noises are emitted from the product,
there is a risk of fire. Unplug the mains connector and contact UniNet service.

Do not use the product near water. Do not spill liquid of any kind on it. Do not connect or disconnect the power plug
with a wet hand as this may cause electric shock. Unplug the product before you clean it. Use only a damp cloth;
do not use liquid or aerosol cleaners. Do not use an extremely flammable spray near the product as the product
contains high temperature parts that may cause a fire.

Be certain that your power source matches the rating listed on the back of the product. If you are not sure, check
with your dealer or local power company before connecting the product.

Do not connect this product to an uninterruptible power supply (UPS).

Your product has a grounded, three-prong plug as a safety feature. This plug only fits into a grounded outlet. If the
plug does not fit, the outlet may be an older, non-grounded type. Contact an electrician to have the outlet replaced.
Do not use an adapter to defeat the grounding.

Install the product near an easily accessible power outlet and avoid damaging the power cord. Do not put anything
on it or place it where it will be walked on. If the cord becomes damaged or frayed, replace it immediately.

If you are using an extension cord or power bar with the product, make sure the total amperes required by all the
equipment on the extension is less than the extension’s rating. The total ratings of all equipment plugged into the
outlet should not exceed 15 amperes.

Do not poke anything in the ventilation slots of the product. You could get an electrical shock or cause hazardous
electrical arcing, which could cause a fire.

The acoustic noise of this product is less than 70 dB (A) as measured in accordance with EN 1ISO 7779.

The operating condition range for your product is: 10 to 32°C and 20 to 80% RH. Operation of the product outside
this range could result in damage to the product.

Do not throw toner cartridges or image drum cartridges into a fire as you may receive burns from a dust explosion.
Ensure loose clothing and hair is kept clear of moving parts when the product is in operation to prevent possible
risk of injury.

Ensure both the product and mains power switches are in the OFF position before connecting the AC power cable.
Always hold the power plug to connect/disconnect the power cable to/from the mains socket. Unplugging by pulling
on the cable can cause fraying and may lead to fire or electric shock.

Use only the power cable supplied. Using a power cable not intended for this product may lead to fire or electric
shock. Do not use the power cable supplied with this product for any other electrical equipment.

Aside from the routine maintenance described in the documentation, do not try to service the product yourself.
Removing the cover may expose you to shocks or other hazards.

Do not make any adjustments other than those outlined in the documentation. You may cause damage that will
require extensive repair work. The provided documentation explains how to get your product serviced by qualified
UniNet technicians. If anything happens that indicating your product is not working properly or has been damaged,
unplug it immediately and follow the procedures in the provided documentation for having your product serviced.



1.2 System Specifications

iIColor 700: System Specifications

Print Speed Up to 9.14 meters/min (30 ft/min)

Technology Single Pass 4 Color LED (CMYK)

Printer Processor? 533 MHz

Media Width Minimum: 6.0 inches (152.4 mm)
Maximum: 8.5 inches (216 mm)

Print Width Minimum: 6.0 inches (152.4 mm)

Maximum: 8.24 inches (209.3 mm)

Print Length

Up to 420 meters (1378 ft)

Substrate Types? Die Cut Label Stock
Kiss Cut Label Stock
Non Die Cut Label Stock
Tag Stock

Print Quality 1200 x 600 dpi

Toner Supplies®

CMY - 11,500 pages @ 5%
K - 11,000 pages @ 5%
(Rated according to ISO/IEC 19798 guidelines)

Drum Supplies*

CMYK - 30,000 pages @ 5%
(Rated according to ISO/IEC 19798 guidelines)

Feeder System

Input roll maximum outside diameter: 8 inches (203 mm)
Core inside diameter: 3 inches (76.2 mm)

Maximum input roll weight: 14 Ibs (6.35 kg)

Cut on the fly, auto cut

Auto page width registration

Front Panel LCD interface

Web management system torque

Auto adjusting form synchronization

Rewinder System

Output roll maximum diameter: 8 inches (203 mm)
Core inside diameter: 3.0 inches (76.2 mm)
Maximum output roll weight: 14 Ibs (6.35 kg)

Dimensions (H X W X D)

Printer & Feeder: 26" x 17.1 "x 21.5" (660 mm x 434 mm X
546 mm)
Rewinder: 16" x 19.75" x 19" (406 mm x 502 mm x 483 mm)

Weight

Printer & Feeder: 110 Ibs (49.9 kg)
Rewinder: 27.65 Ibs (12.54 kg)

Operating Environment

Temperature: 10°C to 20°C (50 to 89.6°F)
Humidity: 20 to 60% RH

Power

110 - 127 VAC, 50/60 Hz @ 1150W
220 - 240 VAC, 50/60 Hz @ 1150W

Certifications

FCC Class A, CE, cTUVus, CCC

Warranty

1year — Parts & Labour

1.Published performance results based on laboratory testing. Individual results may vary.

2.This product is designed and engineered to operate only with genuine UniNet consumables and
certified media substrates. Please contact UniNet for the most current Certified Media List of
substrates available.

3.Letter-size sheets at 5% coverage. Printer ships with a 7,500 page set of starter toners.

4.Based on 500 cut-sheet pages/job.

UniNet reserves the right to change product specifications without notice. Trademarks are the property

of their respective manufacturers. ©2014 Copyright, UniNet. All Rights Reserved. All content is subject

to change without notice.




1.3 Roll Specifications
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Packaging Notes Roll Notes

1.) Image side wound out
2.) Core:
a.) Inside diameter = 3.01" — 3.025"
b.) Thickness = 0.250”
3.) Core must be flush or inset < 1/16” at each end
4.) Core must be attached to the label material
using either double sided releasable tape or low
tack glue
5.) Leading edge must be square and clean
6.) Roll coning is not allowed
7.) Splicing is not allowed
8.) Glue ooze is not allowed
9.) Roll outside diameter = 8.0" maximum
10.) Roll weight = 30lbs maximum

1.) Core plugs must be used

2.) Roll edges must be fully supported to prevent
damage to the roll during shipping

3.) Media roll must be protected from moisture
absorption

Non Die Cut Label Notes Die Cut Label Notes:

1.) Can use either gap sensor or sync mark (see
limitations below)

2.) Left & Right Margins:

1.) No sync marks needed a. Using gap sensor = 0.063” maximum
b. Using sync mark = No Limit

3.) Label gap & gutter spacing 0.125" minimum

4.) Label corner radius
a. Using edge sensor = 0.125” maximum
b. Using sync mark = no limit (ie. Circles)

Kiss Cut Label Notes Sync Mark Notes:

1.) Each label row is to be marked with a sync mark
2.) Sync mark the right edge of the label material as
it unwinds
3.) Sync mark using a black i-mark
a. DIM C =0.125" wide x 0.5” long
b. Offset from edge = 0.030”
4.) Sync marks are to be accurately placed
between each tag or label in the gap area
a. DIM B — TBD (Depends on the size of the tag or
label)
5.) Sync mark density:
a. 1.2 ortho (matte black finish)

1.) Must use sync mark
2.) Left & right margins 0.063” minimum
3.) Label gap & gutter spacing 0.125” minimum
4.) Label corner radius
a. Using sync mark = No Limit
Note: Cannot use gap sense method




1.4 iColor 700 Front View
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1. LED Heads
2. Toner Cartridges (C, M, Y, K) 10. Black Tray Latches
3. Front Cover Release Lever (Blue Handle 11. Width Adjustment Wheel
Behind Cover) 12. Extension Arms
4. Cut On The Fly Module 13. Feeder
5. Feeder Display Menu 14. Top Cover Release Button
6. Spindle Pin 15. Drum Units (C, M, Y, K)
7. Left and Right Media Guides 16. Rewinder
8. Static Bar 17. Fuser Release Levers
9. Front Cover




1.5 iColor 700 Rear View

Printer Network Connection

Printer Power Outlet

Feeder Network Connection

Feeder Power Outlet

Paper Exit Path

Rewinder Plate (Rewinder Not Shown Attached)

Note: USB port is not available
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1.6 iColor 700 Internal Feeder View

Drive Roller

Left and Right Media Guides
Tension Roller

Pinch Roller

Static Bar

Black Tray Latches

Width Adjustment Wheel
Extension Arms

Spindle Pin
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1.7 iColor 700 Rewinder View
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1.8 Feeder Display Menu Functions
1 2 3 4 5

On Line

®
‘M M N
® A \ 4

agrLODE

Display — Displays the feeder status and any error messages

On Line/UP — Toggles between Online and Offline, and also serves as an “UP” selection button

DOWN - Serves as an “DOWN?” selection button

Load Button — Press to complete loading paper

Menu/Select - Accesses the three menus: Feeder Configuration, Feeder Calibration and Network Settings

To access the feeder menu items, press the On Line button to toggle online or offline and gain access to your Menu
system. There are three main menu items: Feeder Configurations, Feeder Calibrations and Network Settings.

M1: Feeder Configurations — NOT AVAILABLE

To access the feeder configuration menu, select On Line to turn the feeder offline. Press the Menu key once for
the M1: Feeder Config menu to appear. The following item is under Feeder Config:

11:
Media

Type

To access the 11: Media Type menu, select the On Line button to take the feeder offline.

To change the media type, hold down the Menu key until the * disappears. Use the UP and DOWN
arrow keys to select the required media. To save the selection, hold down the Menu key again until the
* appears. The media type is now set. To exit press the Menu button. Select On Line button to take the
feeder back online.

M2: Calibrations

Under the Calibrations menu items, it is possible to configure both the Top and Bottom Load Sensors, the Sensor Gap,
Cut on the Fly parameters and Auto Calibration menus.

To access the M2: Calibrations menu, select On Line to turn the feeder offline. Press the Menu key twice for the M2:
Calibrations menu to appear. The following items are under Calibrations:

11: Bot
Load
Sensor

This item configures the parameters for the bottom load sensor. To access the 11: Bot Load Sensor menu,
select the UP arrow until I11: Bot Load Sensor is shown on the display.

To change the settings, hold down the Menu key for about one full second until the * disappears. Use the
UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all values
have been set, press and hold the Menu key for about one full second, until the * appears. The bottom
load sensor values are now set. To exit press the Menu button. Select On Line button to take the feeder
back online.

12: Top
Load
Sensor

This item configures the parameters for the top load sensor. To access the 12: Top Load Sensor menu,
select the UP arrow until I12: Top Load Sensor is shown on the display.

To change the settings, hold down the Menu key for about one full second until the * disappears. Use the
UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all values
have been set, press and hold the Menu key for about one full second, until the * appears. The top load
sensor values are now set. To exit press the Menu button. Select On Line button to take the feeder back
online.

13




13: Reg
Sensor
Back

This item configures the gap between back sensors. To access the 13: Reg Sensor Back menu, select the
UP arrow until 13: Reg Sensor Back is shown on the display.

To change the settings, hold down the Menu key for about one full second until the * disappears. Use the
UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all values
have been set, press and hold the Menu key for about one full second, until the * appears. The back
sensor or gap values are now set. To exit press the Menu button. Select On Line button to take the feeder
back online.

14:
RSEN
Autocal

This item configures the auto calibration values. To access the 14: RSEN Autocal menu, select the UP
arrow until 14: RSEN Autocal is shown on the display.

To change the settings, hold down the Menu key for about one full second until the * disappears. Use the
UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all values
have been set, press and hold the Menu key for about one full second, until the * appears. The
autocalibration values are now set. To exit press the Menu button. Select On Line button to take the feeder
back online.

15:
COTF
Paramet
ers

This item configures the parameters for Cut on the Fly. To access the 15: COTF Parameters menu, select
the UP arrow until I5: COTF Parameters is shown on the display.

To change the settings, hold down the Menu key for about one full second until the * disappears. Use the
UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all values
have been set, press and hold the Menu key for about one full second, until the * appears. The COTF
parameter values are now set. To exit press the Menu button. Select On Line button to take the feeder
back online.

M3: Network Settings

The Network Settings menu items allow configuration of the IP Address, the Subnet Mask and the Default Gateway.

To access the M3: Network Settings menu, select On Line to turn the feeder offline. Press the Menu key three times

for the M3:

Network Settings menu to appear. The following items are under Network Settings:

This item sets the IP Address. To access the 11: IP Address menu, select the UP arrow until 11; IP
Address is shown on the display.

Addlit:aslz To change the settings, hold down the Menu key for about one full second until the * disappears. Use
the UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all
values have been set, press and hold the Menu key for about one full second, until the * appears. The
IP Address now set. To exit press the Menu button. Select On Line button to take the feeder back
online.

This item sets the Subnet Mask. To access the 12: Subnet Mask menu, select the UP arrow until 12:
Subnet Mask is shown on the display.
12:
Subnet | To change the settings, hold down the Menu key for about one full second until the * disappears. Use
Mask | the UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all
values have been set, press and hold the Menu key for about one full second, until the * appears. The
Subnet Mask is now set. To exit press the Menu button. Select On Line button to take the feeder back
online.
This item sets the Default Gateway. To access the 13: Gateway menu, select the UP arrow until 13:
Gateway is shown on the display.
13:
Gateway | To change the settings, hold down the Menu key for about one full second until the * disappears. Use

the UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all
values have been set, press and hold the Menu key for about one full second, until the * appears. The
default Gateway now set. To exit press the Menu button. Select On Line button to take the feeder back
online.

i
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1.9 Printer Operator Panel

2

Ready To Pint

HELP

-’

ENTER ONLINE  CancEL

10 6 5 7 8 4 9
ON: A warning occurs. Printing
ON: Ready to receive data may be possible (e.g. low toner)
1.Ready LED BLINKING: Processing data 6. Attention LED BI‘.INKING' An ertr)lc)r oceurs.
OFF: Offline Printing not possible (e.g. toner
' empty)
OFF: Normal Condition
2. Display Displays the printer status and any 7. Back Button Returns to the previous menu

error messages.

3. Menu Scroll

Enters the Menu mode. In Menu
mode, forwards or reverses the
menu item displayed.

8. Enter Button

In the ONLINE or OFFLINE mode:
enters the Menu mode.

B In the Menu mode: determines the
Press for 2 seconds or longer to .
. setting selected.
jump from top to bottom
Deletes the data being printed or
Switches between ONLINE and received when pressed for two
4.0n Line OFFLINE 9. Cancel Button seconds or longer.
Button

Scrolls the HELP screen

Exits the menu and goes ONLINE
when pressed in the Menu mode.

5. Help Button

Provides advice when an error
occurs

10.Power Save/
Wake up Button

Pressing this button switches the
machine into sleep or wake- up
mode.




2 First Time Setup

2.1 Unpacking and Setting Up the Printer

STEP 1 of 11

-

|

~ B >
r"_’|

P

STEP 2 of 11

With two people lift the top (feeder) box off of the
bottom (printer) box. Open the feeder box and
remove the feeder.

Remove the wing nut on the bottom of the feeder
before placing upright on any surface. Position the
feeder on a level surface. Open the feeder and
remove all packaging material. Close the feeder
door.

Lift the lid off of the printer box. With two people,
remove the printer from the box. Remove all of the
packaging tape from the outside of the printer.

STEP 4 of 11

Press the button to open the top lid.

Remove the fuser shipping lock.
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STEP 5 of 11 \

Pull the drums/toners out of the printer. Remove the
protective film. Place the drums and toners back into
the printer. Ensure all four toners are locked into the
four drums by checking the blue lever. Close the
printer lid.

IMPORTANT: Once the drums/toners are removed,
they must not be exposed to light for more than 5
minutes. To prevent damage, cover them with a dark
sheet or reinstall.

NOTE: All consumables are print ready and do not
need to be replaced upon opening. Once the
consumables have reached their lifespan, please
refer to the appendix on how to replace and install
all consumables

Align the printer with the pins located on the top of the
feeder. Keep the printer level and flush to the front
while lowering it onto the feeder.

STEP 7 of 11

Paper Exit Path

—Rewinder Plate

Unpack the rewinder, removing all of the packaging
tape.

Unwrap the rewinder attachment and prepare to
install on the printer.

Attach the rewinder plate to the feeder using the screws
located on the back of the feeder. Make sure it is in line
with the paper output feeder. You can adjust the
rewinder plate once it is loosely secured by moving it
slightly left or right. Adjust accordingly.

17



STEP 9 of 11

Thumb Screws '

Attach the rewinder mechanism to the plate using the black thumbscrews. Make sure that the rewinder mechanism

is fully supported so it does not bend or break the rewinder plate. The rewinder attachment has been successfully
installed.

STEP 10 of 11

Paper Exit Path

Feeder Network el

Connection .E
Feeder Power Out\el——@

-

Rewinder Plate

Once the rewinder is installed, you need to connect the network and power cables to the correct outlets. All of the
outlets are located on the backside of the iColor 700; connect accordingly.
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B o e

Status: Feauire Load

Press power button on the side of the printer. Wait for the initialization. You should read Ready To Print on the
printer panel and Status: Require Load on the feeder panel. The rewinder attachment has been successfully
installed.
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2.2 How To Get Software Installation Files

STEP 1 of 4

EDGEZPrint j
e AbZ 2015-01-28).71 217.99 MB 29 days ago
217.99 MB 5 months ago
EDGEZ! Guide_R15.pdf 7.99 MB & months ago
EDGEZ2Print_User_Guide.pdf 8.25 MB 29 days ago
BEowv
£ >
UniNet utilizes Dropbox for sending the software file. Please send UniNet an email for sharing folders. After this email
confirmation, UniNet will send a link for the software to your email address. Click the link and you will see the above
website. Click Download on the top right, and click Download as .zip.

STEP 2 of 4
S [

@vﬂz Desktop » - “7‘ [ Search Desktop ol
Organize + New folder B ~ @
43 Favorites “ Libraries Homegroup
P Deskiop L System Folder Q System Folder
Recent Places o
CloudsStation | Adrninistrator . Computer
s IR syctem Folder ] <o Folder
%3 Dropbox Y
iCloud Photos ]
- B Network 875
L_ System Folder i\ File folder
4[5 Libraries -
] Documents L. Virtual Machine
& Music Bl Fietolder
=) Pictures
B videos
» oy Homegroup o
File name: EDGEZPrint.zip -
Save as type: | Compressed (zipped) Folder -
. Hide Folders Save Cancel

Select a place to save your file. (e.g. on Desktop), Click Save.
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&

Open

Extract All..
Agent Ransack...

Copy (FastCopy)
Delete (FastCopy)

Search and Replace...

TortoiseSVN

7-Zip
Edit with Motepad++

Mowve to Dropbox

- (Z‘pp_.‘-e‘ﬂ Fo\de-

Select a Destination and Extract Files

Files will be extracted to this folder:

[C:\Users\Administrator\Desktop\EDGE2Print]

[] Show extracted files when complete

Browse...

e

Go to the place to get your .zip file, right click and select Extract All. On the pop-up window, select a place to save
your folder and click Extract.

STEP 4 0of 4

Now you have the folder for the software installation.
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2.3 Change User Account Control Settings

STEP 1 of 6
"2 Windows Explorer
u—ll
m Visual Studio 2012 >
- I MNotepad 3
N Internet Bxpl ’
(5 Internet Explorer
Music
A< Adobe Acrobat X Bro ’
Computer
iSys
I
= Control Panel
i’ | OpenDifice.crg Cale v —
PEMIERETD Change s¢
ln‘ Microsoft Office Visio 2007 >
Default Programs
@ Microsoft Visual Studio 2008 »
Help and Support
! {d APEX2Print
» Al Programs

In order to prevent some administration window popping up when you use EDGE2Print, Please change your user
account control setting.

Click Start from Windows toolbar, and then click Control Panel.

STEP 2 of 6

E'E Control Panel
-

If using Windows 8, point your mouse to the upper-right corner of the screen, move the mouse pointer down,
click Search, enter Control Panel in the search box, and then click Control Panel.

STEP 3 of 6

4 » Control Panel » «T+: 101 )

Adjust your computer’s settings

Click User Account and Family Safety.
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STEP 4 of 6

‘;Q- B2 » Control Panel » User Accounts and Family Safety » ndll B 4

Central Panel Heme

Harcware and Sound

Programs

* User Accounts and Family
Safety

Appearance and

Click User Accounts.

STEP 5 of 6

<18 CY Cortrol Panel » User Accounts and Family Safety b User Accounts

-4 I
: o

Control Panel Home i

Make changes to y user account
Manage your credentials
Create a password reset disk ;

hangey ture || Administrator
Link online 1Dz w Ademinast
ut file encryption
© Manage ansthe nt
v ol sett

Change my environment
vanisbles

% Parental Controls

Click Change User Account Control settings.

STEP 6 of 6

% User Account Contrel Settings ool =) bl | [ 4y User Account Control Settings 3 ]

hen to be

Choose when to be notified about changes to your computer

Uses Account Control helps prevent potenti mriful programs from making changes to your computer.

User Account Contred helps peevent potentially harméul programs from making changes to your compater.

Alvays notify Always motify
—&=3- Abwarys notify me when: == Mever motify me when:
®  Programs bry to install softwase or make changes to ®  Progeams try to install scftware o make changes to
Ty computer my computer

Timake changes to Windaws settings

Trmake changes to Window

ou need o

dows 7

ded # you routinely install new software
i unfamiliar websites

uppeet User Account Contrel.

Hever notify Never notify

¥ 0K Cancel ¥ OK Canced

Move the left bar all the way down to the bottom and click OK.
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2.4 Change Region Format

STEP 1 of 4 »_ B

To prevent the confusion of measurement units display ED2Print, we recommend to change region format to
English (Canada).

Click Start from Windows toolbar then click Control Panel. (For Windows 8, follow STEP 2 in Section 2.3.)

STEP 2 0of 4

G-,

-<
»

A ®

e F &

Click Clock, Language, and Region.

STEP 3 of 4

[+ [ Py ey T —

P -

Click Region and Language.

STEP 4 of 4

¥ Region and Language.

Fommats | Location | Keyboards and Languages | Administrative

Format:

[English (Canadia) -]
Dutch (Netherlands) a
English {Australiz)

English (Belize)

English (Caribbean)

English (india)

English (Ireland)

English (Jamaica)

English (Malaysia)

English (New Zealand)

English (Republic of the Philippines)
English (Singapore)

English (South Africa)

From the Format list, select English (Canada) and then click OK.
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2.5 How to Install RIP

_ % -@ﬂ ‘ Search ED(

i Organize « 7 Open Include in library = Share with + Burn

STEP 10of4

1stInstall RIP
(i, EDGE2Print_setup.exe

L .

Double click the folder of 1st Re-lnsftall RIP.

NOTE: RIP must be installed before EDGE2Print.

STEP 2 of 4
o B
@-v-vl <« 2015... » 1stIn.. » ~ [ 42 || Search Ist Instali RiP o
Organize ~  |H Open  Bum  New folder (2~ 0 @
Files

51| Prepare_iSys_RIP_v2.5.exe

Click Prepare_UniNet RIP_v2.5.exe to install.

ESEE

o Prepare iSys Rip v2.5

Insert Dongles Into USE Ports And Click Here
To Continue

The KEYLOK Driver and Sentinel Driver will start to install automatically. Wait until the button turns to green. Insert
your dongles and click the button to continue.
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STEP 4 of 4

o5l Prepare iSys Rip v2.5

Done

%

Wait until the Done button turns to green. Click it to finish the installation.
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2.6 How to Install EDGE2Print

STEP 10of4

[+ EDGE2Print » =
Organize « @ Open Share with ~ Burn Mew folder o« O

1stInstall RIP
[, EDGE2Print_setup.exe |

Double click EDGE2Print_setup.exe.

STEP 2 of 4
(& Setup - EDGE2Print E-E

Ready to Install
Setup is now ready to begin instaling EDGE2Print on your computer.

Click Install to continue with the installation.

Click Install to continue. The window will disappear after the installation is done.

Open
Open file location

Pin to Start

Run as administrator

Troubleshoot compatibility

Pin to Taskbar

Send to »

Cut

Copy

Create shortcut
Delete

Rename

Properties

If you're using on Windows 8 and have some administration pop up window when you launch EDGEZ2Print software,
please right click the icon, and select Properties.
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STEP 4 of 4

u EDGE2Print Properties

General | Shotcut | Compatibiity | Security | Detais

i this program isnt working comectly on this version of Windows,
try running the compatibility troubleshooter

Run compatibiity troubleshooter

Compatibilty mode
[ ] Run this program in compatibility mode for

Settings

Privilege level
[#] Run this program as an administrator

g Change settings for all users

0K Cancel Apply

x

Click Compatibility tab, check the box before Run this program as an administrator, and click OK to apply.
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2.7 Setting up the IP Addresses

In order to connect to the iColor 700, you need two predetermined static IP Addresses and two network cables,
one for the printer and one for the feeder.

2.7.1 Setting up the IP Address on the Printer

STEP 1 of 10

deleqatesxm

readme.htm
readme.htm

SectionF 45.html

0 [0 [ i

- See more results

|cmd| % | | Shut down | ¥ |

Keep the network cable unconnected to the printer. Click Start from windows toolbar (For Windows 8, point your
mouse to the upper-right corner of the screen, move the mouse pointer down, click Search), type cmd in the search
dialogue and press Enter.

NOTE: Before you input the IP in the printer, you must check whether this IP is available to use.

2\cmd.exe

B® Administrator; C\Windows\system32\cmd exe.

Microsoft Windows LU n 6.1.26811
Copyright <c> 2889 Microsoft Corporation. A1l rights reserved.

Microsoft Windows [Version 6.1.
Copyright <c) 2089 Microsoft Corporation. A1l rights reserved.

C:Wsers\Administrator>ping 192.168.102.222_ C: \Wsers\Adninistrator>ping 192.168.182_222

[Pinging 192.168.182.222 with 32 bytes of data:r

[Reply from 192.168.182.14%: Destination host unreachable.
[Reply from 192.168.182.14%9: Destination host unreachable.
[Reply from 192.168.182.14%: De: tion host unreachable.
[Reply from 192.168.182_.149: Destination host unreachable.

cs for 192.168.102.222:
Sent = 4, Received = 4, Lost = B <(Bx loss),

C: Wsers\Adninistratord, I

Enter "ping <IP address>" (for here is 192.168.102.222) you want to use for the printer, press Enter.

If it shows unreachable like the right picture, the IP address is not in use and you can use this IP for your printer.
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STEP 3 0f 10

Once your IP address is correct, go to your printer panel.
Press ENTER to enter the printer menu.
Using DOWN arrow to scroll to Admin Setup, press ENTER.

STEP 4 of 10 -

At the Enter Password prompt, enter the 6-digit Admin password by using the UP/DOWN arrow, then Enter.
The default password is: aaaaaa(6 x a).

STEP 5 of 10 -

Press ENTER to select Network Setup.
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STEP 6 of 10 Il

Network Setup
NetWare

Hit the DOWN key until you select IPv4 Address then Enter. Use the UP/DOWN arrow keys to set the value you
need. Press Enter to move across the address. After the value is set, press Back to Network Setup.

STEP 7 of 10 .

LA T
tEE

Hit the DOWN key to select Subnet Mask. Use the UP/DOWN arrow keys to set the value need. Press Enter
to move across the address. After the value is set, press Back to Network Setup. (The default subnet mask is
255.255.255.0).

STEP 8 of 10 I ) -~

- - .

Network Setup
IP Sddress Set

' Gateway Sddress
¥EEE. 5. 02 1

Hit the DOWN key to select Gateway Address. Use the UP/DOWN arrow keys to set the value you need.
Press Enter to move across the address. After the value is set, press Back to Network Setup.
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STEP 9 of 10

Press ON LINE to exit the menu. NOTE: Write down this IP address as you will need for the software.

STEP 10 of 10

i : s era dminds

Connect the cable to the printer and now go back to your computer cmd interface‘, enter "ping <IP address>" (for
here is 192.168.102.222), press Enter again. You should get response this time. If you're not getting reply as in the
picture, please contact your IT support team.
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2.7.2 Setting up the IP Address on the Feeder

STEP 1 of 10

= delegates.xm
2 | readme.htm
2 | readme.htm

£ | SectionF.45.html

- See more results

|cmd| x | | Shut down | » |

g Trouble Shooting ...

e
Keep the network cable unconnected to the printer. Click Start from windows toolbar (If using Windows 8, point your
mouse to the upper-right corner of the screen, move the mouse pointer down, click Search), type cmd in the search
dialogue and press Enter.

NOTE: Before you input the IP in the feeder, you must check whether this IP is available to use.

STEP 2 of 10
B3 Administrator: CAWindows\system32\emd exe 1SS | &5 Admini CAWind 32\ emd.exe ==

Microsoft Windows [Version 6.1.76611
Copyright (c> 2802 Microsoft Corporation. A1l rights reserved.

Microsoft Windows [Uersion 6.1.76811

Copyright (c> 2809 Microsoft Corporation. All rights reserved.
C: \Wsers\Midninistrator>ping 192.168.182.221 C: Wsers\Adninistrator>ping 192.168.182.221

[Pinging 192.168.182.221 with 32 bytes of data:

[Reply from 192.168.182.142: stination host unreachahle.
[Reply from 192.168.102.14 i i reachahle .
[Reply from 192.168.182_142: i reachable .
[Reply from 192.168.102.142: i reachable .

[Ping statistics for 192.168.182.221:

Packe Sent = 4, Received = 4. Lost = @ (8x loss).

C: Wsers\Adninistrator>

Enter "ping <IP address>" ( for here is 192.168.102.221) you want to use for the printer, press Enter. If it shows
unreachable like the right picture, the IP address is not in use and you can use this IP for your feeder.

STEP 3 of 10

. _—] Y — |
Once your IP address is correct, go to your feeder panel. Press On Line to turn the feeder Offline.
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STEP 4 of 10

STEP 5 of 10

11t [P Address
HEG, 486, BA6, ARG

STEP 6 of 10

I1: [P Address

¢ 192,168, 182,221

Hold the Menu button until the * starts to flash. Use the UP and DOWN arrow keys to set the values. Press Menu
button to move across the IP address. When the address is set, hold the Menu button until the * stops to flash.
The IP address is now set.
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STEP 7 of 10

! Subnet Mask
5. 2959, 259, 808

Press the UP arrow key to set the Subnet Mask. The default subnet mask is%5.255.255.0. If that needs to be
changed, follow the same procedure as for the IP Address in STEP 6.

STEP 8 of 10

[7: Gateyay
HAE, 68, BAE, BEE

Press the UP arrow key to get to 13: Gateway. Use the same procedL=|re to set thé Gateway as used to set the IP
Address in STEP 6 if necessary.

STEP 9 of 10

! Setting Metuork tatusi Resuire Load

Press Menu button t return to Oline. Press On Line to pply the network setting. It will show Msg: Setting
Network. After the setting is done, the feeder panel should read Status: Require Load.

NOTE: Write down this IP address as you will need for the software.
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STEP 10 of 10

L
B Administrator: CWindowrenstemdee N RN =l

Microsoft Windows [Version 6.1.76811 -
Copyright (o) 2089 Microsoft Corporation. A1l wights reserved.

IC: Wsers\dninistrator>ping 192_.168.182 221

[Pinging 192.168.182.221 with 32 bytes of data:z

[Reply from 192.168.182.142: Dy ination h unreachahle .
[Reply from 192.168.182.142: Destination host unreachable.
Reply from 192_168_1082.142: D ination h unreachable .
Reply from 192.168.182.142: Destination host uneeachahle.

Ping stat ics for 192.168.182.221:
Packet Sent = 4. Received = 4. Lost = B (Bx loss>.

[C: \WUsers\Adninistrator>ping 192.168.182.221

Pinging 192.168.182.221 with 32 bytes of data:z

Reply from 192.168.182.221: time<ims TTL=64
[Reply from 192.168.10A2.221: time<ims TTL=64
Reply from 192.168.182.221: time<ims TTL=64
[Reply from 192.168.182.221: time<ims TTL=64

Packe Sent 4, Received
Approximate round trip times in milli-second:
— ——— —

Connect the cable to the feeder and now go back to your computer cmd interface, enter "ping <IP address>" (for
here is 192.168.102.221), press Enter again. You should get response this time. If you're not getting reply as in the
picture, please contact your IT support team.

[Ping statistics for 192.168. |

e
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3 Before Printing

3.1 EDGE2Print User Interface

STEP 1 of 1

-4 EDGE2Print R2.2.0.6
- - - P ——

EREN

File  Media  Mesting Variable Data  Banner  Cost Report  Options

Selected Media e
11001 - Matte White Paper

[ Die Cut Mode:
[ Cut On The Fy:

Page Information : Inches

Start Position {-/+): 0.000
Media Width: 6.000
Horizontal Shift (-/+) 0.000 Apply
Guter. 0.125
Alley: 0.125
Print:
Labels to Print 6
Print ]

Image List a

Clear

Fﬁp Folate Ualons e
@0 ©9% ©18 O 2 [T Rip Mimor
Rip Scaling Options
[C] Xpwidth) | 2.000 [ Yheight) 3000

Printer Settings @
Printer Status  |Ready To Print/Tray1 Empty

Page Count 3

A -

1. Toolbar
3. Print Setting
5. RIP Options

2. Preview Screen
4. Image List
B, Printer Settings

This is the interface of EDGE2Print software.
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3.2 Input IP Addresses into EDGE2Print

STEP 1 of 2

(2, Setup IP Addresses _

Printer IP Address : 0.0.0.0} Printer IP Address : 152.168.102 227

[, SetupIP Addresses

Feeder IF Address : 0.0.0.0 Feeder IP Address : 192.168.102.221

Save | Save

Launch the software. This window will pop up automatically if it is the first time. Input the IP addresses for the printer
and feeder, then click Save.

File  Media Mesting Variable Data  Banner  CostReport | Options
Selected Media | Printer 3 | Color Registration
11001 - Matte White Paper Software » | IP Address |
70%“ — Preferences  » Rewinder
(i Setup IP Add (= | B et
Printer IP Address : 192.168.102.222
Feeder IP Address : 1592.168.102.221
Save

If you need to change the IP address, click Options>Printer=>IP Address from the toolbar, you will get the same
window as in STEP 1.
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3.3 Changing the Color Registration

STEP 10f4

File Media Mesting Variable Data Banner  Cost Report | Options
Selected Media | Printer » || Color Registration |
11001 - Matte White Paper Software » IP Address
70[,% — Preferences  » Rewinder

Select Options>Printer=>Color Registration from the toolbar.

Go to the front panel of the printer and select the Media Type and Media Weight, based on the media settings you
selected in the software library. You will want to ensure that your front panel settings and software settings are the
same so you receive the exact results that are to be expected. If you do not have an exact match with the front panel
and media library settings, there is potential for an error on the front panel.

STEP 2 0f 4

4 Color Registration Form E

Currert Cyan: ) o 0 B | Apply |
Cumrent Magenta: ] +- |0 e | Feset |
Curert Yellow: 0 # [0 B Auto Adust |

Prirt Registration Plot |

Density Adjust
| Printer Density Adjust Before Every Job

Click Print Registration Plot.




STEP 3 of 4

<=l ==l [l s [0 ==[0
B | 3B | «[ @
=l = =l = =[] =0
[l == =l = =[] =[]
=l -l 2 B4 | =[] =
-Zb! 26 i 26 ! 26 i 26 D 26 D
25! 25i ?PJ! ?bi ?HD ?hD
=l = | = ==
/:\! ?'ii ?i! ?3i —?dD ):&D
2=l = =l = =[] ==[
=l = =l = H =0 =[O
=ofil] = e = =1
,|9! lsi 719! ‘!Bi 71DD |DD
wl =l il - w0 =0
-l -l ™ Bd | +0 O
-l -l ol ol ol 1 IR
il -+l il -+ < <0
|3! 13. 13! 13i |;'1|:l le:l
=l =l =l = =0 =0
~l -l N B +~@d -0
ol -l offil -l o [
-l -l -l -H -0 -O
-l -l - H -H <O <O
M -3 -l -l -0 -0
-H -l <l -H <0 <O
<l - Sl -l - -0
«~-H -1l -H -H .0 -0
-l -l -l -l ~@ -8
-l -1l S B | -0 -0
-H W S B @ -
D- D- O- ﬂ- OD OD
. I I e .

The printer will print a similar page that will aid in determining the proper registration values across CMY.

IMPORTANT: Use the third page printed to determine the values.

Using a printer's loupe or best judgment, determine the best values. In this case, the correct values are as follows:

C:6 M:4 Y:0; this is because the pixels are perfectly filled within the boxes.

STEP 4 of 4
& Color Registration Form EE

Cumrent Cyan: 1] +- B = Apply
Currert Magenta: 0 - 4 = Fleset
e R

Frirt Registration Flot |

Density Adjust
[ Printer Density Adjust Before Every Job

Input the values determined in the previous step and click Apply to set. NOTE: If there are troubles with the color
density, check Printer Density Adjust Before Every Job.

#
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3.4 Setting up the Cost Calculator

File  Media Mesting Variable Data Banner Cost Report | Options

Selected Media Printer 3
11001 - Matte White Paper | Software b | Cost Calculatar |

Open File Preferences  » Display Options

Print Alignment

Die Cut Mode: Yariable Data
Cut On The Fly: White Toner

Click Options>Software>Cost Calculator from the toolbar.

STEP 2 of 2
s Configure Costing E

Black Toner Cost ﬁ
Color Toner Cost 227.00
Black Drum Cost 159.00
Color Drum Cost 159.00
Fuser Cost 315.00
Transfer Belt Cost 232.00

Waste Bottle Cost 0.00

Media Roll Lengthft) D
Media Rell Cost 0.00
| Save | | Cancel |

Input the price paid for each consumable. This will calculate the cost per label. This value will appear in the Image
List.
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3.5 Changing Units of Measurement

File  Media Mesting Variable Data Banner CostReport | Options
Selected Media Printer 2
11001 - Matte White Paper | Software b | CostCalculator
" OpenFie | Preferences  » | Display Options |
Print Alignment
Die Cut Mods: Variable Data
Cut On The Fy: White Toner

Select Options>Software->Display Options from the toolbar.

STEP 2 of 2
£y Display Options =i E‘E

Measurement Units

@ Imperial

Metric
inches Decimal Places 3 =
mm Decimal Places 3 =

| Enable Borders COn PDFs Displayed

| Save |

Select your preferred measurement units to display and click Save.
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3.6 Changing Borders on PDF Preview

File  Media Mesting Variable Data Banner Cost Report | Options

Selected Media Printer 3
11001 - Matte White Paper | Software | CostCalculator

Preferences  » | Display Options |

Print Alignment
[ Die Cut Mode: Variable Data
[] Cut On The Fly: White Toner

Select Options>Software->Display Options from the toolbar.

&, Display Options E=i=! g

Measurement Units
@ Imperial
Metric
inches Decimal Places 3
mm Decimal Places 3

[¥] Enable Borders On PDFs Displayed

| Save

Check the box to enable borders on PDFs display or uncheck the box to disable.

STEP 3 0of 3
Berry Blue
Saladl Kit

Salad Kit @
ﬁ 4 T/ Wa‘"g
=

Left one has the border enabled and right one has the border disabled.
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3.7 Measuring Your Media

STEP 1 of 6

Page Information : Inches

Start Position (-/<): 0.000
Media Width: 8250
Horizontal Shift (~/+): 0.000 Apply
Gutter: 0125
Alley: 0.125

This is the interface of media page information in EDGE2Print software.

NOTE:
Gutter is the distance of the horizontal gap between labels.
Alley is the distance of the vertical gap between labels.

Measure the total width of paper. Input the value into Media Width.

t

Measure the distance of horizontal gap. Input the value into Gutter.

STEP 4 of 6

Measure the distance of vertical gap. Put the value into Alley.

STEP 5 of 6
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e
|

l
You also should measure the width and height of the label. Save the values for later.

STEP 6 of 6

Measure the right border of the label. The distance from the edge of the facestock to the edge of the should be less
than 2mm because of the sensor location on the guide.
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In order to get more precise value of gutter, there is a better way! Measure as least one meter of the media, and
measure the height of one label. Then calculate the distance of the gap. The longer you measure the media, the

more precise value you will get.

Ex. For the left picture, we measure 9 label lengths plus 9 gutter lengths; the total length is 1171.58 mm
(46.125 inches).

Then measure one label length, which is 127mm (5 inches).

Therefore, the gutter value is (1171.58/9)-127=3.177 mm
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3.8 Loading Media for Continuous Printing

IMPORTANT: Only use with media width ranging from 6” to 8.5” wide. If use with media width less than 6",
please use a narrow fuser.

NOTE: Maximum Printable Width is 8.25".

STEP 1 of 13

No'he secure paper roll packaglng and end pieces

-

Unpack the media, make sure the sides of the roll are straight and flush with the core.
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STEP 2 of 13

<

Make sure the core is thicker than 4mm. If not, when the Toll is running to end, it will go out of the ektension arm.

If you 're using a die cut media, make sure the margin is less than 2mm. If you're using a back/top mark media,
make sure the black mark offset from edge is less than 1mm. If the margin is too large, the sensor can't read the
gap/mark.




STEP 4 of 13

STEP 5 of 13

Pull out the feeder tray and open the front cover.

STEP 6 of 13

KV i \

: | \
i 4 A -
Cut a small piece of the media to adjust the width of the guides.

Open the left and right media guides and place the paper between the guides. Use the width adjustment wheel to
adjust the width, making sure there is no space on both sides and the paper can pass through with no tension.

STEP 7 of 13
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Remove the plastic spindle and insert it into the core of the media roll, ensuring that you keep the edges of the roll
completely flush with the core.

Place the roll in the feeder between the extension arms, with the leading edge of the material at the bottom of the
tray. Adjust the width of the extension arms to fit the paper roll's width, if necessary.

STEP 8 of 13

View #1 View #2

T

Feed the media through, ensuring it is between the tension and pinch rollers.
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STEP 9 of 13

With the media flush against the back plate in the feeder, ensure that there is no extra space on each side of the
media and the left/right media guides.

Feed the media underneath the drive roller and ensure that the paper is at the same level as the top of the rollers.
Back wind the roll if necessary.

Close the red left/right media guides. Ensure that the media is not buckling or too snug against the guides before
proceeding to the next step.

STEP 10 of 13

Close the front cover and push the tray in.
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STEP 11 of 13

__-d.

Power on the printer. When the feeder displays “Status: Require Load,” press the Load button on the feeder.

The media will be fed upwards and cut the substrate, leaving a clean leading edge for printing.

STEP 12 of 13

After the feeder cuts the paper, remove the Cut on the Fly module and scrap material. Put the Cut on the Fly Module
back in position.

STEP 13 of 13

Now the feeder should read Status: Idle.
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3.9 Sensor Calibration for Die-cut Label Printing

STEP 1 of 6
Cpen File Cpen File
Sensor
[ Die Cut Mode: [¥] Die Cut Mode:
[ Cut On The Ry @ Gap

Back

If your media is die cut, select Die Cut Mode. Then select the Sensor Type. (We will use the Gap Sensor as the
example in the following instructions.)

NOTE: If the Calibrate button is red, it means the sensor needs calibration before printing.

STEP 2 of 6

Refer to STEP 1-8 of “Loading Media for Continuous Printing” for how to load the roll of media. After the die cut roll
is loaded into the tray, line up the gap of the labels about one inch below the sensor.

Close the left/right media guides. Backwind the roll to ensure there is no tension when the sensor is calibrating. If
the roll is fully wound and has tension on it, it will skew the calibration. Close the front cover and push the tray in.

STEP 3 0of 6
Open File
Sensor
[¥] Die Cut Mode:
@ Gap
Back

After the media is properly loaded, click Calibrate in the software.
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STEP 4 of 6

[, Calibrate Sensors E
Feeder Settings Media Library Settings
Sensor Type Gap Sensor Type Gap
Sensor Gain 228 Sensor Gain 0
Sensor Window 56 Sensor Window 255

Copy Feeder Settings To Media Library ] [ Copy Media Library Settings To Media Library

Run Calibration

Click Run Calibration. The printer will run the paper to the nearest gap mark.
NOTE: You can use previously stored values in the feeder from the last use by clicking Copy Feeder Settings To
Media Library. You can also manually input the values for Sensor Gain and Sensor Window under the Media Library
Settings, and then click Copy Media Library Settings To Media Library to update the values in the feeder.

Status g

3

l.\ Calibration Failed

— ¥,

If the calibration did not work, an error screen will pop up.

Adjust the roll again and make sure the gap of the label is about one inch below the sensor then perform another
calibration.

STEP 6 of 6

: _——
After calibration is done, go to the feeder, follow STEP 9-13 of "Loading Media for Continuous Printing" to finish

loading process.

You are now ready to add a label image and print a die-cut label.
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4 Printing
4.1 Selecting a Media ID

STEP 1 of 2
File Mesting  Variable Data  Banner  CostReport  Options

Click Media from the toolbar.

STEP 2 of 2

[ iSys Certified Media
Paper | Plastic | Foil
Glossy ‘ Matte || Semigloss | Tag | Texture | Piggyback | Fuorescent ‘
Media ID Media Description Media Vendor  Media Type Media Weight
1100 - it Wit Paer
11018 - Matte White Paper | Latex Impregnated RR22 3.2 mil. Hi-White Kraft | UPM Raflatac | Plain Litra Heawy 1
11019 - Matte White Paper | Matte Laser RP54 3.2 mil. Hi-White Kraft UPM Raflatac | Plain Uttra Heawy 1
11020 - Matte White Paper | 548 Laser RP51 3.2 mil. Hi-White Kraft UPM Raflatac | Plain Uttra Heawy 1
11021 - Matte White Paper | 406 Jetite RP54 3.2 358 White Kraft (2.2mil.) |UPM Raflatac | Plain Uttra Heawy 1
11022 - Matte White Paper | 50 Jetlaser RP54 2 Bmil White Kraft UPM Raflatac | Plain Ultra Heawy 1
11023 - Matte White Paper | Jetcolor RP54 2.8 mil White Kraft UPM Raflatac | Plain Ultra Heawy 1
11024 - Matte White Paper | 20# Laser Plus RP54 2.8 mil White Kraft UPM Raflatac | Plain Ultra Heawy 1
11025 - Matte White Paper | Jetlaser Translucent RR22 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Uttra Heawy 1
11026 - Matte White Paper | Matte Litha RP51 408 White Kraft UPM Raflatac | Plain Ultra Heawy 1
11027 - Matte White Paper | Jetlaser Translucent RP54 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Uttra Heawy 1
11028 - Matte White Paper | Fasson Uncoated Litho WS/AT20M/1.2M PET | Avery Dennison | Plain Heavy
The media list will open. It contains medias that have been certified by UniNet. You can select one from the list by
double click.




4.2 How to Create a New Media ID

STEP 1 of 5

File | Media | Mesting Variable Data Banner CostReport  Options
To create a new media, click the Media tab on the toolbar.

STEP 2 of 5

(L iSys Certified Media

Paper | Plastic | Foi
Glossy ‘ Matte | Semigloss | Tag | Texure | Piggyback | Fluorescent ‘
Media D Media Description Media Vendor  Media Type Media Weight
[ 11001t Wt Popr WG il Macoo P Ukmbeow 1
| 11018 - Matte White Paper | Latex Impregnated RR22 3.2 mil. Hi-White Kraft |UPM Raflatac | Plain Uitra Heawvy 1
11015 - Matte White Paper | Matte Laser RP54 3.2 mil. Hi-White Kraft UPM Raflatac | Plain Ultra Heawy 1
11020 - Matte White Paper | 54# Laser RP51 3.2 mil. H-White Kraft UPM Raflatac | Plain Uitra Heawvy 1
11021 - Matte White Paper | 408 Jetlte RP54 3.2 358 White Kraft (2.2mil.) |UPM Raflatac | Plain Ultra Heawy 1
11022 - Matte White Paper | 50# Jetlaser RP54 2. 8mil White Kraft UPM Raflatac | Plain Uitra Heawvy 1
11023 - Matte White Paper | Jetcolor RP54 2.8 mil White Kraft UPM Raflatac | Plain Uttra Heawy 1
11024 - Matte White Paper | 50# Laser Plus RP54 2.8 mil White Kraft UPM Raflatac | Plain Uitra Heawvy 1
11025 - Matte White Paper | Jetlaser Translucent RR22 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Uttra Heawy 1
11026 - Matte White Paper | Matte Litho RP51 40# White Kraft UPM Raflatac | Plain Ultra Heawy 1
11027 - Matte White Paper | Jetlaser Translucent RP54 3.2 mil Hi-White Kraft |UPM Raflatac | Plain Uttra Heawy 1
11028 - Matte White Paper | Fasson Uncoated Litho WS/AT20M,/1.2M PET | Avery Dennison | Plain Heawvy

In the pop-up window above, select the base media for your new media and right click on the Media ID.

STEP 3 of 5
[£ Create & Update User Media ¢ . e oo

Media 1D
Media Description

Media Vendor

Media Type

Media Selected : 11007 - Matte White Paper

based on 11001 -

Media Weight

Medium Light
Medium
Hea

(&, Create & Update User Media - =HAEnl X

Media Selected : 11001 - Matte White Paper

Media ID based on 11001 - iSys_New_Matte

Media Description For iSys matte roll

Media Vendor iSys

Media Type Media Weight
- Medium Light -

Letterhead Create This Media Medium

Bond Hea

Recydes - (B er— -

then click Create This Media.

Fill in the Media ID, Media Description and Media Vendor, select Media Type and Media Weight from the list,
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[, iSys Certified Media

e — e i

Paper | Plastic | Foil | White Toner
Glossy | Matte | Semigloss | Tag | Texture | Piggyback | Fuorescent
Media D Media Description Media Vendor  Media Type Media Weight

| 1001 Mot Wrke Pper MAGetids MacTac e Uhafeswy 1

- 11007 - Matte White Paper Fasson LaserCopy Jet 300/55010M/46HLF Avery Dennison | Plain Ltra Heawy 1
11018 - Matte White Paper Latex Impregnated RR22 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Ltra Heawy 1
11015 - Matte White Paper Matte Laser RP54 3.2 mil Hi-White Kraft UFPM Raflatac | Plain Ultra Heawy 1
11020 - Matte White Paper Bd#f Laser RP51 3.2 mil Hi-White Kraft UPM Raflatac | Plain Uttra Heawy 1
11022 - Matte White Paper B¢ Jetlaser RP54 2 8 mil White: Kraft UFPM Raflatac | Plain Ultra Heawy 1
11023 - Matte White Paper Jetcolor RP54 2.8 mil White Kraft UFM Raflatac | Plain Ltra Heawy 1
11024 - Matte White Paper B0# Laser Plus RP54 2.8 mil White: Kraft UFM Raflatac | Plain Ltra Heawy 1

i 11026 - Matte White Paper Matte Litho RP51 408 White Kraft UPM Raflatac | Plain Uttra Heawy 1

11027 - Matte White Paper Jetlaser Translucent RP54 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Uttra Heawy 1
11028 - Matte White Paper Fasson Uncoated Litho WS/ATZ0M/1.2M PET | Avery Dennison | Plain Heawy
based on 11001 -iSys_New_Matte | For iSys matte roll iSys Plain Uktra Heawy 1 I

Your new media will be displayed in the list.

NOTE: UniNet provides a variety of substrates that have been rigorously tested for optimal print quality, ease of use
and consistency from the beginning of the job until the end. The iColor 700 was designed and engineered to operate
with approved consumables and certified media which ensure superior quality and resolution every time. UniNet is
not responsible for damage or consequences arising from the use of non-certified media or consumables.

Paper

P 0

Matte

Media ID

Media Description  Media Yendor

Media Type

mcedon 11001 5N Vit ForSyamtond Sy Pin | U ey 1

Media Weight

based on 11001 -iSys_New_Matte

Show Only User Media

There is an option that allows for only the new media to be displayed. Check the Show Only User Media box to
view only new/custom media IDs.
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4.3 Editing a Newly Created Media ID

oTEr ot =
(s iSys Certified Media E

Paper || Plastic | Foi
Glossy | Matte Semigloss | Tag | Texture | Piggyback | Fluorescent |
Mediz ID Media Description Media Vendor  Media Type Media Weight
11001 - Matte White Paper | MACiet Ink Jet MacTac Plain Ultra Heavy 1
11018 - Matte White Paper | Latex Impregnated RR22 3.2 mil. Hi-White Krsft | UPM Raflstac | Plain Ultra Heawvy 1
11015 - Matte White Paper | Matte Laser RP54 3.2 mil. Hi-White Kraft UPM Raflatac | Plain Ultra Heawy 1
11020 - Matte White Paper | 548 Laser RP51 3.2 mil. Hi-White Kraft UPM Raflstac | Plain Ultra Heavy 1
11027 - Matte White Paper | 408 Jetlite RP54 3.2 358 White Kraft 2.2mil) | UPM Raflatac | Plain Ultra Heavy 1
11022 - Matte White Paper | 508 Jetlaser RP54 2.8mil White Kraft UPM Raflatac | Plain Ultra Heavy 1
11023 - Matte White Paper | Jetcolor RP54 2.8 mil White Kraft UPM Raflatac | Plain Ultra Heavy 1
11024 - Matte White Paper | 50# Laser Plus RP54 2.8 mil White Kraft UPM Raflatac | Plain Ultra Heavy 1
11025 - Matte White Paper | Jetlaser Translucent RR22 3.2 mil Hi-White Kraft | UPM Raflstac | Plain Ultra Heavy 1
11026 - Matte White Paper | Matte Litho RP51 40# White Kraft UPM Raflatac | Plain Ultra Heawvy 1
11027 - Matte White Paper | Jetlaser Translucent RP54 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Ultra Heavy 1
11028 - Matte White Paper | Fasson Uncoated Litho WS/AT20M/12M PET | Avery Dennison | Plain Heawy
T S T S
iSys_new_Matte
If the new media needs to be edited, right click on the new Media ID.

STEP 2 of 2
(5 Create & Updste User Media - - ==
Media Selected
Media ID {Sys_new_Matte
Media Description For iSys matte rolls
Media Vendor iSys
Media Type Medis Weight
- Light -
Letterhead > . Medium Light
B Update This Media Mediam
Recycled = - -
Delete This Media
Error Deleting Active Media ==

|@'\ You Can Mot Delete The Current Selected Media

This window will allow you to edit. After editing, click Update This Media button to update the information. If you
want to delete it, click Delete This Media button.

NOTE: You can only delete the media you created. The certified medias in the library can't be deleted.
You can't delete the media that is currently been selected, or an error will be displayed.
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4.4 Adding Label Images to Print

STEP 1 of 5

File | Media Mesting

Banner

| Open

Load Page Information

Save Page Information
Exit

File Media Mesting Variable Data Banner Cos
Selected Media
11018 - Matte White Paper

Open File
Sensor

[¥] Die Cut Mode:
@ Gap Calibrate
) Back

drop your PDF file to the Preview Screen.

To open a file, choose File=>Open, or click Open File button to select your PDF file, or you can simply drag and

NOTE: EDGE2Print uses PDF files only. Under Windows 8, drag and drop doesn't work.

STEP 2 of 5

%

You can load multiple PDF files as on

are aligned in columns.

g as they have the same dimensions, but the number of PDF files shouldn't
exceed the column numbers on the die cut media. The images will show in the Preview Screen, and multiple files
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STEP 3 0of 5

Image List

Remove | File Name Toner Cost
| Delete | Salad_1 0.03910

| Delete | Salad_2 0.02356

| Delete | Salad_3 0.03384

| Clear |

The information of the images will show in the Image List on the left.

STEP 4 of 5

Print: 1.453 feet
Labels to Print: 10

| Prirt |

Enter how many labels you want to print. EDGE2Print will automatically round the amount of labels up to complete
a full row. Then click Print to start printing labels.

NOTE: If you loaded multiple PDF files, the copy nhumber indicates the amount of each PDF file.

STEP 5 0of 5
Feeder Mot Ready E’E

@Y Feederis NOTIdle
"Y' Click 'OK' Once Feeder is Idle To Continue Printing
~ Or Click 'Cancel' To Exit This Print lob

OK l | Cancel |

If the feeder panel doesn't read Status: Idle, a message will show. Please go the feeder to load the media and get
the feeder to the idle status and click OK to continue printing.




4.5 Adjusting the Print Alignment

STEP 10of4

File Media MNesting VariableData Banner CostReport | Options
Selected Media Printer 3
11001 - Matte White Paper | Software | CostCalculator
Preferences  » Display Options
Print Alignment
[T Die Cut Mode: Variable Data
7] Cut On The: Fly White Toner
[Es Print Alignment Setup =NAeEh X
Non Die Cut
Pattem Header Length [22.00]
Pattem Footer Length 2200
Die Cut
Pattem Header Length 2200
Pattem Footer Length 22.00

Select Options—>Software>Print Alignment from the toolbar. Set the proper Pattern Header Length and Pattern
Footer Length.

NOTE: For every print job, you need to adjust vertically where the printer starts printing the label images.

Recommendation: The header needs to be 22 inches or longer in order to adjust the color registration. The footer
can be set to 0 without affecting the color registration.

STEP 2 0f 4

22"

Use header
patterns to
adjust and align
labels

B

' L4 I .
Check the start position. The 22 inches of header color patterns are used for calibration. The gap between labels
should be in line with the gap on the label line. If the labels are not aligned after the third copy, adjust the start
position value according to how far the label is from the gap.
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STEP 3 of 4

Page Information : Inches

Start Position (-/+): 0.000
Media Width: 8.169
Horzortal Shift (-/+) 0.000 Apply |
Gutter 0.125
Alley 0.125

Start Position
Positive Value (+): Move print down
Negative Value (-): Move print up

STEP 4 0of 4

Page Information : Milimeters

Start Posttion: 0.000
Media Width 210.000
[ Honzortal Shit (/<) 0000 || Aoy |
Gutter: 3.200
Aley: 3.200

We can also use Horizontal Shift(-/+) to make adjustment to the labels.
Positive Value (+): Move print right
Negative Value (-): Move print left




4.6 Nesting

Nesting is a feature where users can print multiple graphics of the same size and layout in a sequence without stopping.

For example, you have three salad labels of the same size and need 10 Mediterranean, 5 Berry Blue and 25 Field Berry
for one run. Rather than printing these individually, you can print them all in the same run, one after another without

stopping. By using the nesting feature you will save time of setting up the job and save media by using one header and
footer rather than three.

STEP 10of4
File Media Mesting Banner CostReport Set
Selected Media
11001 - Matte White Paper
Open File
Sensor
| Die Cut Mode: Top
@ Gap Calibrate
Back
Page Information : Inches
Start Position: 0.000
Media Width: 2500
Horizontal Shift (/<) 0.000 Apply
Gutter: 0.125
Aley: 0.125
Prirt:
Labels to Print: 10 Add Edit
| Printt Nesting |
Click Nesting on the Toolbar. Notice that the Add and Edit buttons have become available and the Print button is
now labeled Print Nesting.

STEP 1 of 4

I Vba] 107500

Prrter Sans

PagaCowe

b = b - b - ol
Load the PDF fileffiles and enter the number you want to print. Then click Add and job will be saved for printing and
the images will disappear from the Preview Screen. The Print Nesting button will now display Print Nesting: 1

STEP 3 0f 4
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File Media Mesting Banner CostReport Setup Options
Selected Media
11001 - Matte White Paper

Open File
Sensor

[¥] Die Cut Mode:
® Gap Calibrate
©) Back

Frint:
Labelsto Prirt 2 add || Edt

Prrt Nesting: 2 ]

Image List

[ o= ]
Repeat the above step until all the printing jobs are loaded. For example, we have 3 jobs loaded, Print Nesting: 3
will be displayed. Click that, and the printing process will start right away.

STEP 4 of 4 |
s Nesting Options =N X

Adjustable White Space : Milimeters
Update
Between Nested Jobs 0.000}
Exit
PDF Name(s) Labels To Print Length
Salad_1 10 0.44
Salad_2 5 0.22
Print: 3.281 fest Salad_3 25 1.00
Labels to Print: 25 Add Edit
| Prirt Mesting: 3 |
\ &

If you need to edit the nesting job, click Edit button and the option window will pop up. You can add white space
between nested. Label quantity can also be adjusted across each nested job. Once the necessary changes have
been made, click Update then click Exit to return.

#
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4.7 How to Activate Variable Data (iVDP)

STEP 10of4

File Media Mesting Variable Data Banner Cost Report | Opticns

Selected Media
11001 - Matte White Paper

Cpen File |

Die Cut Mode:
Cut On The Fy:

Printer b

Software 3

Preferences »

Cost Calculater
Display Options
Print Alignment
Variable Data
White Toner

Select Options>Software>Variable Data.

Dongle ID:  [E

STEP 2 of 4
(i, Variable Data Setup == E
] -

‘ Import ‘

Make sure the Dongle ID is correct and click Import.

 Open . v
<O [ 4 £

@

« | Al Files

Open [v] [ Conced

Open the folder that holds the Key and select Variable Data_ Enabled.dat, then seléct Open.

STEP 4 of 4

File  Media Mesting Variable Data

Banner  Cost Report

Setup Options

The Variable Data tab is now on the toolbar. If not, close the software and reopen it.
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4.8 Printing Variable Data

STEP 1 of 5

File Media MNesting VariableData Banner
Selected Media
11001 - Matte White Paper
Sensor
[¥] Die Cut Mode:
@ Gap Calibrate
") Back
Page Information - Inches
Start Posttion {-/+): 0.000
Media Width 8163
Horizortal Shift {-/+): 0.000 Apply
Guter 0.125
Aley: 0.125
Prirtt
Labels to Print 20
[ Print

Cos

Select Variable Data from the Toolbar. The Labels to Print option now becomes unavailable.

STEP 2 of 5

(£ EDGE2Print R22.06

File Medis Mesting | Vafisble Data CostReport

Options

E=NEERT )

Selected Meda
11001 - Masse White Paper

Open Fie |

Dne Cut Mode:

Page Information : Inches
Rart Foslion (/+).
Mecdia Width.

Horzortsl Shit (/).
Gutinr-

Hey.

0.000
0000 |
0125
(373
Frre: 1 B8 fest

Labeis 1o Prind

Image List

Toner
Remove File Name CostiEst]

(| Delete | Ror 10 0.03432

| e
Rip Rotate Optiona
B0 ©% ©180 &7 Rips Mo
Rip Scaling Opiona

| Xpidh) 3453 | Theight) 2333

Prirter Settings
Prirber Halus |7

Page Court

Flora & ?fﬂﬂf

__‘Flora & Fauna

Carden Cevter

English Daisy

o sz I
95

150

_‘ZFIera & ?gggg

3053

Brown Eyed Susan

S = TN
_?fora & Fauna

P~ymn e e

\.'.I.II.I.|.I.|.|.|.|.|.|.|..1..I

Morning Glory

Open the PDF file that contains your variable data. Once loaded, click the Print button.

Important: If only the first image of your variable data is visible on the preview screen, then you did not click the
Variable Data tab before you load the file. You should clear the file and redo STEP 1 & 2.

Limitations: Variable Data has a 1.9GB limitation. If the file is larger than 1.9GB, the software will divide the data

into separate jobs of 1.9GB each.
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STEP 3 0of 5

Variable Data Processing

RIP Processing PDF Page 12 712
Separations Processing 12 712
Estimated Job Size 20 Megabytes
‘ Printing Job #1

Job #1 will appear.

Once the Print button is clicked, this window will pop up. The RIP and Separations Procession will take a while to
fully process depending on your hardware. Once they have processed, their screens will turn green and a Printing

STEP 4 of 5

RIP Processing PDF Page 48 Of 48
Seperations Processing 48 Of 48
Estimated Job Size 134 Megabytes
Job #1 Contains 6 Labels

‘ Print Job H#2 1 ‘ Cancel ]

If the print job is larger than 1.9GB, and you selected Pause between 1.9GB print jobs option, this window will appear
after the first job is printed and you must click Print Job #2 to start printing the next job. If you did not select Pause
between 1.9GB print jobs, then job #2 will automatically start printing. Please refer to STEP 5 for printing options.

STEP 5 of 5

File  Media Mesting Variable Data Banner  Cost Report | Options
Selected Media Printer r
11001 - Matte White Paper | Software . | Cost Calculator
7Open File Preferences  » Display Options
Print Alignment
Die Cut Mode: | Variable Data
Cut On The Fy: White Toner
. Variable Data Setup e (0 e \
DongleID: 18

Printer Output Processing
HAlways Verically Processing

|
|
@ Always Horizontal Processing
Always Ask
|
|

Printing Options
Pause Before Printing
Pause Between 1.9 GB Print Jobs
| Generate Cost Report After Printing |

Click Options->Software->Variable Data from the toolbar, you will see the Options of variable data printing.




4.9 Printing Using Banner Mode

STEP 1 0of 5
File Media MNesting Variable Data Cost Report  Options

Selected Media
11001 - Matte White Paper

[] Cut On The Fly:
EDGE2Print has a feature which can print a long PDF file using the banner mode.

Select Banner from the toolbar. The Die Cut Mode now becomes unavailable.

STEP 2 of 5
.r;'_ EDGE2Print R2.20.5 o=, e )

File Media Mesting Variable Data | Banner  CostReport  Setup Options
Selected Media
11001 - Matte White Paper

] Cut On The Fy:

Page information : Inches

Start Position: 0.000

Media Wicth: 8268

Hoczortal St (/) 0000 [ ety |
Gutter 0125

ey 0125

Prrt: 6.188feet

Labels to Prnt 2
[ Pt

Image List

Femove Fie Name Toner Cost
| Delete | ThisSidelp_long 073210

[ o |
Ry Rotate Options

Load the PDF file into EDGE2Print.




PDF/Label Size Mismatch g

%A File Name: ThisSideUp_long.pdf
RaY' Media (200,000 x1320.800)
PDF {101.600 x 1346.200)

If this dialogue pops up, it means you dLid not click the Banner tab before ‘you load your file. Please redo STEP 1
&2.

STEP 4 of 5

Page Information : Milimeters

Start Posttion: 0.000
Media Width: 304,800
Horizontal Shift (~/+): 0.000 Loply
Gutter: 50.000
[Niey: 20.000 |
£ EDGEXried R2205
| File Mefa  Hesteg

Smimctnd Mady
11001 - Matte Wit Pacar

GoenFin_|

0t O Tow Pyt
|

|wuwmu|-m

Amt Poator.

ok it
Hesirortal Shit /=)
Guiier

[ e
Fig Fictatn Ortiors

l @0 0 -]
Pertar Setngn

If the media width is large enough to take up multiple columns of the banner, it will show in multiple columns. You
can set a value to the Alley to separate each column.
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STEP 5 of 5

Fage Information : Milimeters

Start Position 0.000

Media Width 304.800

Horizontal Shift (-/+) 0.000 Aoply |
[Gutter 50.000 |

Aley 20.000

th

THIS END
UP

A

(o

5 Beginning

You can set a value to Gutter if you want a gap between multiple banners. The output of your banner will look like
the layout above.

NOTE: The limitation of PDF size is 200 inches (5080 mm) long. If your graphic is larger than this, you will need to
have your graphic designer create a multi-page PDF with 199 inches (5054.6 mm) sections or less. The multi-page
PDF can now be imported into the software and printed in sequence.
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410 How to Activate White Toner

EDGEZ2Print allows you to print white spot color and print white underneath the color for transparent media and black
media.

STEP 1 of 7

Share with » Burn Mew folder

| EDGE_White.icc
5 Install White ICC.exe

Install the ICC profile for using white toner first.
Open the folder of Install White ICC. Double click Install White ICC.exe.

STEP 2 of 7
o5 Install ICC for White Toner (= i)

Click to Install
White ICC for

EDGE !

Click the button Click to Install White ICC for EDGE!

STEP 3 of 7
ozl Install ICC for White Toner E

DONE!

Click to Exit

Wait until the process finishes. Close the window by click the center button.

STEP 4 of 7
File  Media MNesting Variable Data Banner  Cost Report W‘_
Selected Media Printer b
11001 - Matte White Paper Software 3 Cost Calculator
Open File | Preferences  » Display Options
Print Alignment
Die Cut Mode: Variable Data
Cut On The Fy: White Toner

Go to Edge2Print, click Options->Software->White Toner from the toolbar.
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[, White Toner Activation ! - | (=] iE_I
Impart
License
Click Import License.

(& Open g

Dongle  [E

@\Jvl <« Clarissa (E) » White Toner [ 49 ||| Search white Taner )
Organize v Newfolder e 0 @
¢ Favorites ) White_Toner_Enabled.dat
P Desktop
L Recent Places
CloudStation 3
%2 Dropbox
[ iCloud Photos
& OneDrive
P Desktop
' Libraries
% Homegroup
A Administrator 52
File name: White_Toner_Enabled.dat -

Open the folder that holds the Key and select White_Toner_Enabled.dat, then select Open.

STEP 7 of 7

File Mesting  Wariable Data  Banner  Cost Report Options
2y 15ys Certified Media
Paper | Plastic | Fail | White Toner
Plastic || Paper
Media ID Media Descrption  Media Vendor Media Type Media Weight
SO0D1-Glos e PETfor Whte T80 TD  Pan Ukmfemy 1
Now, click Media from the toolbar, you will see a White Toner tab with two categories Plastic and Paper.




4.11 Printing using White Toner

(s iSys Certified Media

Paper | Plastic | Foil | White Toner

Plastic || Faper

Media 1D Media Description  Media Vendor Media Type Media Weight

5001 - o Cea PETfor Wi T8 T80 Fan |Ukaean |

Selected Media
50001 - Gloss Clear PET for White W

Media for White Toner Selected
Open File | 1 h

Select a media under White Toner category. You will see a "W" on the right side of the media name which indicate
that the media for using white toner is selected.

STEP 2 of 2

[ EDGE2Print R2.2.0.6

File Media Mesting Variable Data Banner CostReport  Options
Selected Media
50001 - Gloss Clear PET for White w

[T Die Cut Mode:
[C] Cut On The Fiy:

m

Page Information : Inches

Start Position (-/#): 0.000
Media Width: 8500
Horizontal Shift (-/+). 0.000 Apply
Gutter: 0.125
Aley. 0.125

Prnt: 1.115feet

Labels to Print: 6
Prirt
D pefes I pefes

image List FWRETRVEIR| Ar1ag poig
Remove File Name Toner Cost

Delete | Salad_3 007134
Rip Rotate Options
@0 ©9 © 180 © 20 [ Rip Mimor

Rip Scaling Options
Hiwidth)  3.453 Yheight) 4333

Printer Settings
Prirter Status | Ready To Print/Tray1 Empty

Page Count

0 Pe[ES i D PE[ES 2

The printing process for white toner is the same as the normal one. It works for regular, nesting, variable data and
banner modes.
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4.12 How to Set Up the Rewinder

STEP 1 of 6

Loosen the Core Adjustment Knob. Place a core on the Rewinder Spindle. Make sure the core is the same width
of the media you're printing on or slightly smaller. If the core is the exact same width as the media, ensure it is placed
flush against the left end disk. If the core is slightly smaller, place it in the center using your best judgment.

STEP 2 of 6

Cut a section of the media you'll be using to print. Place that piece of media flush against the Left End Disk and
adjust the Right End Disk to fit the media. Ensure that the paper is flat against the core and there is no excess
space on each side of the End Disks. Tighten the Core Adjustment Knob.

NOTE: If there is excess space between the core and the Left/Right End Disks OR the media is not flat against the
core, it will cause the roll to wind haphazardly, not wind tightly and create bubbles in the roll.
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STEP 3 0of 6

Loosen the Lockdown Knob for positioning. When you are ready to print, send a small section of labels to the
printer. While the section is printing, adjust the rewinder left/right using the Width Adjustment Knob, aligning the
rewinder with the paper path as the labels exit the machine. Once the paper path and rewinder are aligned, tighten
the Lockdown Knob.

STEP 4 of 6

Plug the DC Power In, and then plug the end of the power cord into a socket. Turn the rewinder on by turning the
switch to REV.
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STEP 5 of 6

| § ]
Press Print in the software when your job is ready. As the paper exits the printer, lift the Dancer Arm and bring the
media underneath the Dancer Arm and up onto the core. Secure it to the core using a section of media or excess
label.

Lower the Dancer Arm downwards to begin winding the material onto the core. Place your hand gently on top of
the core to create some initial tension at the beginning of the roll. Once the media is winding, release the Dancer
Arm gently downwards onto the paper. The roll will continue to wind.

NOTE: Winding speed is determined by the position of the Dancer Arm. Lowering the arm will speed up the winding
and lifting upwards will slow it down.

NOTE: If the roll seems to be winding too loosely, place your hand on the top of the roll while it's winding. This will

increase the tension momentarily. Be careful when doing this as too much tension will cause the roll to wind unevenly
or create bubbles between the reams.

STEP 6 of 6
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When the roll is done, turn off the rewinder. Unscrew the Core Adjustment Knob on the Spindle. Remove the roll
from the Spindle and return the Right End Disk to its initial position.
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5 Software Features and Options

5.1 How To Print a Full Bleed Die Cut Label

The following is a detailed guide to create an oversized label image on top of a die cut label. The term over bleed
means that there is a small portion outside of the actual label known as the “overprint area”. Excess toner of the label
is printed on to this area so that the actual dimensions of the label are met with clear, clean cut edges. The cutting is
done after we print.

WARNING: Print full bleed die cut label may damage the consumables!

Label Label ” “ Label
Label Label Label
Label |H| Label Label
Label Label Label

STEP 1 of 3

!

Width

e |, .l

Measure the label length, label width, gutter and alley.
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STEP 2 of 3

Rip Scaling Options
V| Xiwidth)  50.500

Page Information : Milimeters

Start Position:
Media Width:
Horizontal Shift {-/+):
Gutter:

Aley:

0.000
215.500

0000 | Aeply |
3175
1175

3.175mm, alley is 3.175mm.

Input the number into proper place. For example, the label width(X) is 50.5mm, label height(Y) is 127mm, gutter is

Rip Scaling Options
| Xwidth)  52.500

Page Information : Milimeters

Start Position:
Media Width:
Horizontal Shift (-/+):
Gutter:

Alley:

STEP 3 of 3

0.000
215.500

0.000 Apply
1175
1175

alley becomes 1.175mm.

If you want to print 1mm bleed outside of the label size on both direction, just minus gutter and alley by 2mm, and
add 2mm to width and height. So width becomes 52.5mm, height becomes 129mm, gutter becomes 1.175mm and




5.2 Install Your Own ICC Profile

STEP 1 0of 8
Selected Media r

based on 11001 -iSys_MNew_Matte
W 4

When you are using the created media, you can install your own ICC profile. Click the colourful square button on the
right side of your media's name.

Selected Media
based on 50001 -iSys White

NOTE: If the media is created under white toner category, you don't have the color management option.

TIP: If you have a three-column media and you want to compare three different color managements on the same
sheet, you can do like this. Choose one ICC profile for your label, load it into the software. Choose another ICC
profile, load the same image into the software. Repeat this one more time, and click print, then you will have three
columns of the same label but with different ICC profiles.

STEP 2 of 8
= |5 il

= RIP ColerPro Setup Form

et Document Controls.
Crvmmide color management in job
Seuidnte e

4 b

Use Iate color manapement

e

Coler ncfustments

Curmerd Medhia Celer Oplicrn Bounding Box r— T
Software Wil Leave RIP Linsdusted & Medalox AetiBox
Only Apoly Lnesrization Heeston Cropk
& Fopky KT Pl with RIF Sehup Optiorss TamBian
ColorPro Optons
Fovaiable Cuipus Profies
install Chutput I0C Profle
P Seltrz
Irput Profle Setiing Output Rlendenng intents
7] Coler manage gray as YK Main rtert Sy
Toeat spct colors as CMYK 1548 Riandseng Cotorns
4] Uss Partzna PLUS e ek tn Colormatric. = Black Genarstion  Mssamu
Mgamumirk 20 - Backthveshold  H00

7] Presorve 100% process black e e
Chemas vt nade n b dmkar ghtar
7| Dvepent process colors
Drop White Otyacts.
—— ] CMYKimages 5y -
7] Ovement grmy mages i FGBmaow’ |9y M
et 1007 black L e
Outpet Contely
Lgheng. Grapte: At 050 -

Faster -

Setup Options.

This dialogue allows you to setup your own color information. Make sure you checked Abply ICC Profile with RIP
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STEP 3 0f 8

Available Output Profiles

| Install Outout ICC: Profiie

ICC Name ICC Intemal Name it
APEX_Generalicc APEX_Generalicc
APEX_Legacyicc APEX_Legacyicc E
Commercial A Linear %dat on film

v EDGE_Generl icc
Fogra 35L Fogra 351
Fogra 43L Fogra 43L
GRACol (CGATS TRO06) GRACol (CGATS TRO0E) il
ICoA 2t icon A

Click Install Output ICC Profile.

Favortes
[ Desitop

o o it

| Recent Places -]

o P L Computer

3 Libwaries

*| Documents t‘b Netwerk
& Music LY
i Pictires 1CC_Theough_Psice
B videos

File name: 1CC_Through PS.ice

]
2

W L W

Cancel

STEP 4 of 8 .

Select the ICC profile, click Open.

STEP 5 of 8

g7 ICC Name and Comment

Change ICC Name
| Change ICC Cemment

Save

Change the ICC name and IbC comment if you need, then click Save.

STEP 6 of 8

Available Output Profiles

GRACol (CGATS TRO06) GRACol {CGATS TRO06)

14001 Cream Textured_opt jcc

Install Output ICC Profile

ICC Name ICC Intemal Name 2
7| EDGE_Generalics EDGE_Generslicc

Fogra 39L Fogra 3L

Fogra 43L Fogra 43L =

IFRA 261 IFRA 261
IFRA 30L IFRA 30L
Vimeen Thin enfi i amheimtnmdnd faninn e Denan aobhebine i

Then your ICC profile appears in the list.
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STEP 7 of 8

Invalid ICC Profile Type

(ot

Device/Profile Class = prtr
Color Space Signature = RGB

0K |

l'

Notice that only CMYK ICC profile can be installed. If it is a RGB ICC profile, this window will pop up.

Curment Media Color Options
Software Will Leave RIP Unadjusted
Only Apply Linearization

@ Apply ICC Profile with RIP Setup Options

STEP 8 of 8

Bounding Box:
MediaBaox
BleedBax

@ TrimBox

| Save | | Cancel |

ArtBox
CropBox

After making changes, click Save to save and close the dialogue.




5.3 RIP Settings

STEP 1 of 2

Selected Media

iSys_new_Matte ' j

EDGEZ2Print has a feature to customize RIP settings for your labels if using own created media other than those
under White Toner category.

Click the colourful square button on the right side of your media's hame.

STEP 2 of 2
adl RIP ColorPro Setup Form [ ) |

Current Media Calor Options [ sae | [ Coa ]
Software Wil Leave RIP Unadjusted
Orly Apply Linearization

© Apply ICC Profiie with RIP Setup Options

ColorPro Options
Available Output Profiles
Install Output ICC Profle

ICC Name ICC Intemal Name o
Commercial A Linear %dot on film
| EDGE_Generalicc EDGE_Generalicc =
Fogra 35L Fogra 33L
Fogra 43L Fogra 431
GRACol [CGATS TRODE) GRACo! (CGATS TRO0E)
IFRA 261 IFRA 261
IFRA 30L IFRA 30L
[ o Thin monfiln in Snesinm im Denmn solibobine a0
Rip Settings
Input Profile Setting Output Rendering Intents
V] Color manage gray as CMYK Main intert iSys -
Treat spot colors as CMYK 1Sys Rendering Options
V] Use Pantone PLUS Style Saturation - Black Generation  Maximum -
Mzimumink 200 - Blackthreshold  90.0
Input Document Controls
Overide color management in job == {J red 00
Simulate paper color of job -
blue {J yelow 00
] Preserve 100% process black
Overide overprint mods n job darker " lighter 0.0
7] Overprint process colors
Drop White Objects
7] CMYKimages  iSys -
Overprint grays
R —— 7] RGBimages  iSys -
Qverprnt 100% bisck Use black point compensation
Output Cortrols
Ul T Lghting: Graphic Ats D50 -
Color adjustments: ~ Faster -

Click Apply ICC Profile with RIP Setup Options on the top and you will see RIP Settings on the bottom. You can
customize your RIP settings and click Save to save them.

NOTE: To apply the settings to your label images, you have to remove your file from the list and make the change
of the setting, then reload the images again.




5.4 Installing the Fonts in the RIP

@\Jv + Computer » Local Disk (C)) » Windows » E v [43 | Searcr »
Organize » 4 Open Share with = Burn New folder = | 17]
¢ Favorites , - ] -
B Desktop addins 13/07 3 File fold o
& Downloads AppCompat 13/07 /200 PM
= Recent Places AppPatch
CloudStation 1 assembly
Boot
-2 Libraries Branding
*| Documents CsC
o' Music Cursors
= Pictures debug
B videos diagnostics
DigitalLocker
% Homegroup Downloaded Program Files
ehome
& Computer en-US
&L Local Disk (C3) 4 Fonts
ca Clarnissa (E) Globalization 14 2 1:50 AM  File folde 3
& Releace Misvesrver) (R:) > L} :
Fonts ed: 01/10/2014 219 PM
I File folder Date i: 13/07,/2009 9:20 PM
A
.
Go to Computer=>Disk(C:)=>Windows, double click Fonts.

@.\_J,v A » Computer » Local Disk (C:) » Windows » Fonts » v |4 earch Fonts 0

Control Panel H . . .
S < Preview, delete, or show and hide the fonts installed on your

Font settings computer
Get more font information —
online Organize » &~ o

Adjust ClearType text
Find a character B

Change font size

Academy Aharoni Andalus Angsana AngsanalP Aparajita
Engraved Bold Regular New
LET Plain
Medium
Abg Abg
Arabic Arial Arial Arimo Batang BatangChe
Typesetting Unicode Regular Regular
Regular MS Regular
Yy Abg Abg ibeisii® Abg
Blackletterd Bock Bookman Bookshelf Broadway Browallia
86 BT Antiqua Old Style Symbol 7 BT Regular MNew -

Text Services and Input
Language

Personalization 'A

Press Ctrl+A to select all of the fonts within the folder, and press Ctrl+C to copy all of the fonts.

207 tems
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i‘. Local Disk (C:)
ca Clarissa (E:)
& Release Misvseneer) (R:)

552 items

s B514ceme.fon

s 8514cemg.fon

- 4 m

= | 5
@“ J__v' » myFonts v | 43 P
Organize Include in library = Share with « Burn New folder » | &

¢ Faverites - -
Bl Desktop + | B5f874.fon
& Downloads +»  B5f1255.fon
-, Recent Places s B5f1256.fon
Cloudstation 5| s 8sf257fon
s B5s874.fon
g Libraries +  B551255.fon
¢ Documents s B551256.fon
@' Music s 8551257 .fon
b= Pictures s B514fifon
B videos s | B514fixe.fon
s B514fing.fon
3 Homegroup s B514fixrfon
s 8514fot.fon
™ Computer +»  8514cem.fon

paste all of the fonts into this folder.

Create a new folder in a convenient location (e.g. a folder named myFonts on the Desktop), then press Ctrl+V to

Windows Explorer
=

m Visual Studio 2012

l Motepad
=) Interet Expl
(=5 Internet Bxplorer

|J\t Adobe Acrobat X Pro

15ys

=
l | OpenOffice.org Calc

¥ -’ Microsoft Office Visio 2007

@) Microsoft Visual Studio 2008

»

STEP 4 of 9

Open Windows Start and find UniNet RIP, click to open the software.
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iSys RIP |_|

= .=

iSysRIP  Edit vcmm Output  Fonts
|4 X e s = A 3 ) e s |

Installed fort ‘Utsaah-Bolditalic' in TrueType fomat
Installed font ‘Utsaah-ltakc’ in TrueType format.
Installed font “ani' in TrueT ype format

Installed font Y ani-Bold' in TrueType fomat

Installed fort YYerdana' in TrueType format

Inctalled forit "erdana-Bold'in TrueType format,
Installed font Verdana-ltalic' in TrueT ype fomat.
Installed font “erdana-Bolditalic' in TrueType format.
Installed font “iaya' in TrueType format

Installed font “ijaya-Bold' n TrueT ype format.
Installed font Yrinda' in TrueT ype fomat

Installed forit "rinda-Bold in TrueType famat.
Installed ford ‘webdings' in TrueT ype fomat
Installed forit "Wingdings-Regular’ in TrueType format.
Installed font *wingdings2' in TrueT ype fomat.
Inzstalled font *w/ingdings3' in TrueType fomat.
Installed font /A dobeF” in TiueT ype format.
Installed font \J okemanletPlain' in TrueT ype format
Installed font JohnHandyLetPlain' in TrueT ype format.
Total ime: 2 minutes 21 seconds (00:02:21.792)
Job Completed: fontist

Click the Red Stop Light Icon to pause the program.

STEP 6 of 9

iSys RIP
:iSysRIP Edit Preview Color Output | Fonts

T i [ -~ R

List Fonts

Installed font Utsash-Bolditalc’ in TrueType fome
| Installed fort Utsaahitac' in TrueT ype fomat Proof Fonts...
| Installed font Vand in TrueT ppe format.

Installed font Vare-Bold' in TrueType fomat. Delete Fonts...
Installed font Yerdana' in TrueT ype fomat

Installed font Verdana-Bold in TrueType format

Installed font Verdanadtabc' in TrueT ype format.

Installed font Verdana-Bolditalic' m TrueType format.

Installed font Viaya' in TrueT ype format

Instalied font Viapa-Bold in TrueeT ppe format

Installed font Vinda® in TreeT ppe format

Instalied font Vimda-Bold in TrueType format.

Installed font \Webdings' in TrueType fomat.

Installed font Wingdings-Regular’ in TrueType foimat

Installed font ‘Wingdings2' n TrueT ype lomat.

Installied font Wingding:3' in TrueT ype format.

Installed fort ZwAdobeF" in TrueType fomal,

Instalied font ‘JokermanLetPlain' in TrueType format

Installed font YohnHandyLetPlain' in TrueT vpe format

Total time: 2 minutes 21 seconds (00:02-21.792)

Job Complated: fortkst

= | & ]

Click Fonts=>Install Fonts from the toolbar.

Install Fonts

Look in: | Desktop ~OF B

4 Libraries

*& Homegroup
A Administrator

/& Computer

|| € Network

myFonts

File name: | Install

Files of type: AH Font Files (" pfa;” pfb;" off " ttc:" 1tf) ' | Cancel

Find the new folder you just created which has all of the fonts. Double click to open.
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STEP 8 of 9

Install Fonts e
Lookin: ), myFonts -0 e E-
Name . Date modified =
« 21205__.TTF 31/12/1997 9:54 AM
{4 35101 .TTF 31/12/1997 9:54 AM
« 40240__TTF 31/12/1997 9:56 AM
Il | 46152__TTF 31/12/1997 9:54 AM
\ 50416_ .TTF 31/12/1997 958 AM -
4 m »
Flename:  "35191__TTF" "40240___TTF" “46152__TTF [ install
|| Files of type: ';_NlFm Files (" pfa;" pfb;".olf " ttc;" 1tf) v Cancel |
A< z
Press Ctrl+A to select all of the fonts, and click Install.

STEP 9 of 9 _

iSys RIP =B
iSysRIP Edit Preview Color Output Fonts

Rl 1 v i ) = A 3 s s pover

%% Waming fort Utzash-Bold' already exsts on desk. [X% -
%% Warming: ford 'Utsaah-Bolditalic' akeady exists on disk. %%
%] Waming font Utsaah-ltabc’ already esasts on disk. |55

%% Waming: forit Vani' skeady exsts on disk. [%%

%% Waming fort VaniBold aleady exists on disk. %%

%% Waming: fonil Verdana' aready exists on disk. JX%

%[ Waming: fort Verdana-Bold akeady easts on disk. J5%

%% Waming fort Verdana-talic' aready exists on disk. JX%

X% Waming: fort Verdana-Boldilac' skeady exsts on disk. 5%
E%] Waming: font Viapa' sleady exists on disk. 5%

%%] Waming: font Viaya-Bold akeady exists on disk. J%

%% Waming font Viinds' akeady sdsts on disk. [%%

*%[ Waming: font Vinda-Bold akeady exists on disk. %

Z%] Waming: fort ‘Webdings' aeady exsts on disk. JX%

%%] Waming fort ‘Wingdings-Regular’ aeady exists on disk. [¥%
2% Waming: fort Wingdings2' skeady exsts on disk. [4%

%% Waming: fort WingdingsT abeady ests on dick. JX%

%% Waming font 2wihdobeF' skeady exists on disk. [5%%

Z%] Waming fort JokermanLetPlain’ already exists on disk. %%
Total time: 2713 seconds (D0.0002713)

Job Completed: fonilist E

The fonts will start to install to the RIP. Once the job has been completed all of the fonts will be available in the
EDGEZ2Print Software.




5.5 Rip Rotate Options

STEP 1 of 1

Rip Rotate Options

" BERNELLOS " BERNELLOS

Ohvesil Olvedil

SOT1INYIY

SOTTANYIY

" BERNELLOS

Ohvesil Oliveoil

BERNELLOS

i
W&
g
4 :

AT

When the Rip Rotate Option is set to O all PDF files will preview in their original orientation. The Rip Rotate Options
will allow for the desired orientation. For example, if you check 90 in the RIP Rotation Option, the image will rotate
90 degrees clockwise.

To rotate the graphic, first you will need to clear it from the EDGEZ2Print software, select the desired rotation, then
re-import the graphic.

Adjustments can now be made in the Page Information Section for correct placement on the selected media.

NOTE: If the graphic does not fit the width of the media when rotated, a red error will show on the Image List.
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5.6 Rip Scaling Options

STEP 10of1
Rip Scaling Options

V] Xpwidth) 2618 7] Yiheight) 4232

yeo i J | 7y ¥ BERNELLOS BERNELLOS BERNELLOS
 BERNELLOS " BERNELLOS ()hue' 11 ()hve' 01]_ (,hve' 011
OI- Extra Virgin -l °l- t.-:umwnéil @‘ @

BERNELLOS BERNELLOS BERNELLOS  °
=\ (V. =

Olivecil OBbvecil OBveoil

| ; » wll ‘ '»
Py FN V : & @) @)
ol- Extra Virgin -1 o]- Extra V\o - - 5 % i = E ﬁ! E B 5 ﬁt i

If the size of your image is not the same as the label size, you can use the RIP Scaling Option to adjust it. Input the
width of label into X(width) and put the height of label into Y(height).

Select the desired scaling values, then select Clear in the Image List section. Re-import the graphic into the
EDGEZ2Print software. The Preview Screen will now show the graphic scaled according to your specifications.

NOTE: When scaling an image, some resolution may be lost and result in pixilation. If this is the case, consult your
graphic designer and have them properly scale the image rather than using the Scaling feature.
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5.7 Bounding Box Option

STEP 10of4

Selected Media S
iSys new '

The software offers option to use different bounding box for your PDF file to print. First, select a user defined media,
then click the colourful square.

STEP 2 of 4

-
o-! RIP ColorPro Setup Form -

Curent Media Color Options
) Software Will Leave RIP Unadjusted
@ Only Apply Linearization
~) Apply ICC Profile with RIP Setup Options

Bounding Box

@ MediaBaox

) BleedBox

) TrimBox

On the right side, you will see the Bounding Box option. Select the bounding box you want to use and click Save.
The default set is MediaBox.

STEP 3 0of 4

G EDGEPrintR2205 4 o o =B %

File Media MNesting Variable Data Banner CostReport Setup Options
Selected Media -
121

Open File

[] Die Cut Mode:
[Z] Cut On The Fiy:

bl

el

et
e R WD M

sandans asadusn
o8TIXHY
oo U WU M.
e ——
a8TIXFIY

O 09l E1r0 P shymas Hops esnig
e
gy ey Eumpecdn prusdlo
0% 091 102 Byns 015 o)
T i iy
gy esea Eumpedioy o

Page Information : Inches

Start Position: 0.000
Media Width £.500
Horizontal Shift (-/+); 0.000 Apply
Gutter 0.125
Aley: 0.125

Print: 3.497 feet QL oo
Labels to Print 10 ~

Image List = o C

Remove File Name Toner Cost

Delete | Apex_Tapas(8.27x3.15) 0.06956 J D l D
(< ° (< °

Rip Rotate Options
90 @5 © 180 © 27 [ Rip Miror

egx

— {gi
Clear ig%
ggn

§5

VSOIDITAa YWIED

)

31010'093212

|| Rip Scaling Options
[ Xqwidth)  [4.000 [T Yiheighty

L

3 I0932‘|2

31010°

3

s

E
Printer Settings 1
7 L 7

Printer Status | Ready To Print/Power Save

Page Court

Then load your PDF and print your_j-ob. This is the PDF ;vith-Medi:aBox.
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This is the same PDF as the one above with TrimBox.
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5.8 Saving and Loading Page Information

L Save As . . %

\olm) ||+ page ~ | ¢4 ||| search Page )
Organize » Mew folder == 9
-
- . § )
E Cniies Name Date modified Type
Bl Desktop

No items match your search

m

& Downloads
= Recent Places
CloudStation

File | Media Mesting Variable| =

- Documents
Open J e
= Pictures [ m }
Load Page Information File name: | [T *
Save as type: IAII files (%) 'j

| Save Page Information

Exit < Hide Folders [ swe || conce |

Click File=>Save Page Information from the toolbar. The current page information in the software will be saved.

2. Open . — %

\\:}Q | » Page v|¢,|| Search Page 2|
Organize » MNew folder B== = Ol @
F Caiories & Mame : Date modified Type
B Desktop | | | page_info 29/03/20149;33 AM  File
4 Downloads 7
| Recent Places
CloudStation
File | Media Mesting Variable|| = b
| Documents
OF'E” Music
=/ Pictures
| Load Page Information E videos ) ]
- 4 . »
Save Page Information File name: page info -
Exit [ open [v] [ conce |
To load the saved page information, click File>Load Page Information. Select the page information file you saved
before, and then click Open.
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5.9 How to View Cost Report

From EDGEZ2Print toolbar click Cost Report. The Cost Report will be displayed within a text file. Notice that the 3 PDF
files are in the job and each are separately calculated. The TOTAL COST of all jobs is calculated at the bottom of the
page along with the TOTAL LENGTH.

STEP 1 of 3

File Media Mesting Variable Data  Banner i_Cu:ust Report | Setup Options
To view cost report, click Cost Report from the toolbar.

STEP 2 of 3

" Cost Report.txt - Notepad o B

File Edit Format View Help
Kost Calculation Report

Media Name : 11001 - Matte White Paper

Media width : 207.500 mm

Gutter : 3.175 mm

Alley : 3.175 mm

ek e
Job Set #1 -- Same Label Using 3 Columns

PDF Name : 14001-2_wine_(4.0x6.0)_N.pdf
Label size : 66.5057 x 107.5055 mm

CMYK Coverage
K= 7.3%

= .3%
Cc = 13.0%
M = 14.8%
Y = 31.6%
Toner Cost per Label(CMYK) = 0.0265
Total Length Column #1 = 0.44 m
Total Labels To Print =3 1|2
Total Toner Cost(CMYK) = 0.3177
Total Cost per Label = 0.0306
Total Cost per Job = 0.3673

ek e
* Job #1 Total Cost = 0.3673 *
ek Tk

Fdd ok kAT T TER KA R

* TOTAL COST = 0.3673 =

* TOTAL LENGTH = 0.4427 m *
e Sl S e 23 TSl o e Sl o

The following window will pop up. This is the cost report for the last printing job.
There are three different types of job costing given:
Total Toner Cost = This is the cost of toner ONLY

Total Cost Per Label = This takes into account the wear and tear done on the drums, transfer belt and fuser. It also
adds in the cost of the media based on the length of material used.

Total Cost Per Job = This is the total cost for the amount of labels you selected to be printed, including the toner,
drums, transfer belt, fuser and media.




STEP 3 0of 3

File Media Mesting Variable Data Banner Cost Report | Options
Selected Media Printer 3
11001 - Matte White Paper | Software 3 | Cost Calculator
Open File Preferences b Display Options
Print Alignment
Die Cut Mode: | Variable Data
Cut On The Fly: White Toner
& Variable Data Setup [E=gEE)
Dongle ID :

Printer Output Processing
@ Always Verically Processing
) Always Horizontal Processing
1 Abways Ask

Layout Display Processing
@ Display Verical (Longer Processing)

") Display Horizontal

Printing Options
[T] Pause Before Printing
[7] Pause Between 1.9 GB Print Jobs
[¥] Generate Cost Report After Printing

For variable data printing, you can select the above to generate cost report after printing.
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5.10 Reprint Option

File  Media Nesting Variable Data Banner CostReport | Options
Selected Media Printer »
11001 - Matte White Paper Software »
| Preferences | Reprint |
Warnings
[ Die Cut Mode: Language
= E-1 =1
Click Options->Preferences->Reprint from the toolbar.

85! Reprint Options =lE

V] Enable Reprint

Check the box. This will enable the reprint option.

[EL Printing Error Detected

Waiting For Error To Be Corrected
Closing this Window Will Terminate The Print Job

Time Elapsed  00-039

If an error occurs, the error window will appear. Leave the window untouched.

STEP 4 of 5

. ; . 4
Go to your printer and feeder, correct the error, make the printer showing Ready to Print and feeder showing Status:
Idle. (When the printer asks to Continue of Cancel, press CANCEL button.)

STEP 5 of 5
EL Printer Continue Condition : 55 inches E
[ Cancel Job ] [ Restart Job From Beginning ] [ Continue Job From Emor I
I Advanced
?rf;fneta[_)r:jsiance 0 n |

After the machine is recovered, turn back to the software, you have options to Cancel Job, Restart Job from
Beginning or Continue Job from Error. Choose one from the window above. If you choose to continue job from
error, you have an advanced option to determine the offset distance from error.
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5.11 Warning Options

5.11.1 Consumable Warning

STEP 1 of 3

File Media Mesting Variable Data Banner CostReport | Options
Selected Media Printer 3
11001 - Matte White Paper Software ¥
w Preferences » Reprint
Warnings
Die: Cut Mode: Language
g Ty The Chee

Click Options->Preferences->Warnings from the toolbar.

STEP 2 of 3

ol Warnings

| Job vs Consumables

Fuser Width vs Media Width

Check the box before Job vs Consumables will enable the warnings for running out consumables.

Warning

Possible Empty Consumables If Current Job Is Printed With :
Toner Black

] | Cancel |

For Example, after you click Print, if black toner is not enough to finish the job, the warning window will pop up.
You can click OK to continue printing or click Cancel to cancel the printing job.
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5.11.2 Fuser Warning

STEP 1 of 3

File  Media Mesting Variable Data Banner CostReport | Options
Selected Media Printer »
11001 - Matte White Paper Software ¥
|w| | Preferences » | Reprint
| Warnings
Die Cut Mode: Language
- - g Ty The Chee -
Click Options->Preferences->Warnings from the toolbar.

STEP 2 of 3
ol Warnings E

Job vs Consumables

| Fuser Width vs Media Width

Check the box before Fuser Width vs Media Width will enable the warning of the fuser width according to the
media width.

STEP 3 of 3 )

Page Information : Inches Warning

Start Position: 0.000

Media Width: 5.000 This Job Will Require A Narrow 6 Fuser
Horizontal Shift {-/+): 0.000 |Wl

Guiter: ooo0

Aley: 0.000

For example, after you click Print, the warning window wiill pop; up to let you knoW the correct size of fuser should
be used according to the Media Width you input in Page Information. You can click OK to continue printing or click
Cancel to cancel the printing job.

NOTE: This warning window will pop up every time if it's enabled.
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5.12 White Toner Warning

STEP 1 of 3

File  Media

Selected Media
11001 - Matte White Paper

Nesting

Open File

Die: Cut Mode:

g Ty The Chee

Variable Data  Banner

Cost Report

Printer »
Software 3
| Preferences  » | Reprint
| Warnings
Language

If you have white toner license activated, you can turn on/off the white toner warning.
Click Options->Preferences->Warnings from the toolbar.

STEP 2 of 3

o=l Warnings

EESEN X

Job vs Consumables

Fuser Width v Media Width

| White Toner

Check the box before White Toner will enable the warning of the White toner cartridge before printing.

STEP 3 of 3
™ S

Selected Media
50001 - Gloss Clear PET for White

Selected Media
11001 - Matte White Paper

3
! Please Put White Toner In The Printer
[ OK l | Cancel |
h —— = = =
il ==
3

! Please Put Black Toner In The Printer

[ o

| |

Cancel |

h 3

If you select media for white toner, the warning to put white toner in the printer will pop up. If you select media other
than white toner, the warning to put black toner in the printer will pop up.




6 Trouble Shooting and Maintenance

6.1 Toner Cartridge Replacement

STEP 1 0f 8 STEP 2 0of 8
, Bl IR |

(a) Pull the colored toner release lever on the
cartridge to be replaced fully towards the front of
the printer.

Press the cover release and open the printer’s top

cover fully. Note the position of the four cartridges. (b) Lift the right hand end of the cartridge and then

draw the cartridge to the right to release the left
hand end as shown, and withdraw the toner
cartridge out of the printer.

STEP 3 of 8 STEP 4 0of 8

Clean the top of the ID unit with a clean, lint free cloth. Gently shake the new cartridge from end to end
Remove the new cartridge from its box but leave its several times to loosen and distribute the toner evenly
wrapping material in place. inside the cartridge.
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STEP 5 0f 8

STEP 6 of 8

.
o=

/()

/| 2l

Remove the wrapping material and peel off the
adhesive tape from the underside of the cartridge.

Insert the left end of the cartridge into the top of the
image drum unit first; pushing it against the spring on
the drum unit, then lower the right end of the cartridge
down onto the image drum unit.

STEP 7 of 8

STEP 8 of 8

Pressing gently down on the cartridge to ensure that
it is firmly seated, push the colored lever towards the
rear of the printer. This will lock the cartridge into
place and release toner into the image drum unit.

Gently wipe the LED head surface with a clean, lint
free cloth.

Finally close the top cover and press down firmly at
both sides so that the cover latches closed.
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6.2 Image Drum Replacement

The printer contains four image drums: cyan, magenta, yellow and black.

CAUTION! Static sensitive devices, handle with care.

STEP 2 of 8

Press the cover release and open the printer's top
cover fully.

Note the position of the four toner cartridges (a) and
image drums (b) it is essential that they go back in the
same order.

WARNING! If the printer has been powered on, the fuser will be hot. Do not touch.

CAUTION! The green image drum surface at the base of the ID unit is very delicate and light sensitive. Do not
touch it and do not expose it to normal room light for more than 5 minutes. If the drum unit needs to be out
of the printer for longer than this, please wrap the cartridge inside a black plastic bag to keep it away from
light. Never expose the drum to direct sunlight or very bright room lighting.

STEP 3 0of 8

Holding it by its top center, lift the image drum,
complete with its toner cartridge, up and out of the
printer.

With the colored toner release lever (1) to the right, pull
the lever towards you. This will release the toner
cartridge from the drum.
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STEP 5 0f 8

STEP 6 of 8

Lift the right hand end of the toner cartridge (1) and
then draw the cartridge to the right to release the left-
hand end as shown (2) and withdraw the toner
cartridge out of the image drum cartridge. Place the
cartridge on a piece of paper to avoid marking your
furniture.

Place the toner cartridge onto the new image drum
cartridge as shown. Push the left end in first and then
lower the right end in. (It is not necessary to fit a new
toner cartridge at this time unless the remaining toner
level is very low.)

STEP 7 of 8 ‘

Push the colored release lever away from you to
lock the toner cartridge onto the new image drum
unit and release toner into it.

STEP 8 of 8

Holding the complete assembly by its top center, lower
it into place in the printer, locating the pins at each end
into their slots in the sides of the printer.
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6.3 Replacing the Transfer Belt Unit

The transfer belt unit is located under the four image drums. Switch off the printer and allow the fuser to cool for about

10 minutes before opening the cover. #

STEP 1 of 6

STEP 2 of 6

Press the cover release and open the printer’s top
cover fully.

Note the positions of the four toner cartridges (a) and
image drums (b) it is essential that they go back in the
same order.

STEP 3 of 6

Lift each of the image drum units out of the printer
and place them in a safe place away from direct
sources of heat and light.

Locate the two fasteners (a) at each side of the belt
and the lifting bar (b) at the front end. Turn the two
fasteners 90° to the left. This will release the belt from
the printer chassis. Pull the lifting bar (b) upwards so
that the belt tilts up towards the front, and withdraw
the belt unit (c) from the printer.

CAUTION! The green image drum surface at the base of the ID unit is very delicate and light sensitive. Do not
touch it and do not expose it to normal room light for more than 5 minutes. If the drum unit needs to be out
of the printer for longer than this, please wrap the cartridge inside a black plastic bag to keep it away from
light. Never expose the drum to direct sunlight or very bright room lighting.
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STEP 5 of 6

STEP 6 of 6

Lower the new belt unit into place, with the lifting bar
at the front and the drive gear towards the rear of the
printer. Locate the drive gear into the gear inside the
printer by the rear left corner of the unit, and lower
the belt unit flat inside the printer.

Turn the two fasteners (a) 90° to the right until they
lock. This will secure the belt unit into place. Replace
the four image drums, complete with their toner
cartridges, into the printer in the same sequence as
they came out.

Close the top cover and press down firmly at both
sides so that the cover latches closed.
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6.4 Fuser Replacement

The fuser is located inside the printer just behind the four image drum units.

WARNING! If the printer has recently been powered on, some fuser components will be very hot. Handle the
fuser with extreme care, holding it only by its handle, which will only be mildly warm to touch. A warning label
clearly indicates the area. If in doubt, switch the printer off and wait at least 10 minutes for the fuser to cool

before opening the printer cover.

STEP 1 of 5

Press the cover release and open the printer’s top
cover fully.

o
0— c—O

STEP 2 of 5

"'-.

C

S
/

Identify the fuser handle (a). Pull the two fuser
retaining levers (b) towards the front of the printer so
that they are fully upright. Remove the new fuser from
its packaging and remove the transit material.

STEP 4 of 5

Holding the new fuser by its handle, make sure that it
is the correct way round. The retaining levers (b)
should be fully upright, and the two locating lugs (c)
should be towards you.

Lower the fuser into the printer, locating the two lugs
in the slots in the metal partition which separates the
fuser from the image drums .Push the two retaining
levers (b) towards the rear of the printer to lock the
fuser in place.
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STEP 50f 5

Place the drums back into the printer and replace the
lid.
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6.5 Clearing Paper Jams

STEP 1 of 17

Press the cover release and open the top cover.

STEP 3 of 17

STEP 2 of 17

Note the position of the four toners cartridges (a) and
image drums (b). Itis essential that they go back in the
same order.

STEP 4 of 17

Lift the image drum, complete with its toner
cartridge, up and out of the printer

Put the assembly down gently onto a piece of paper to
prevent toner from staining surrounding areas and to
avoid damaging the green drum surface and cover.

CAUTION: The green image drum surface at the base of the Image Drum is very delicate and light sensitive.
Do not touch it and do not expose it to normal room light for more than 5 minutes. If the drum unit needs to
be out of the printer for longer than this, wrap the cartridge inside a black plastic bag to keep it away from
liaht. Never expose the drum to direct sunliaht or verv briaht room liahtina.
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STEP 5 of 17 ‘

STEP 6 of 17

Check if any sheets of paper are visible on any part
of the belt unit (a. release handle, b. belt, c. fuser or
d. fuser pressure release lever).

To remove sheet from the front, lift the sheet from the
belt and pull it forward into the internal drum cavity to
withdraw the sheet.

STEP 7 of 17

To remove a sheet from the central area, separate
the sheet from the belt surface and withdraw the
sheet.
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To remove a sheet in the fuser; push the two retaining
levers (e) towards the rear of the printer to release the
fuser. Withdraw the fuser unit using the handle (f).




STEP 9 of 17 ‘

STEP 10 of 17

Press release lever (g) and pull trapped paper from
the fuser.

Replace fuser unit into the machine and move locking
levers (e) toward the rear of the machine.

STEP 11 of 17

Starting with the cyan image drum unit nearest the
fuser, replace the four image drums into the drum
cavity, making sure to place in the correct order.

STEP 13 of 17

STEP 12 of 17

S
\ iy

Open the rear exit tray (h) and check for sheets of
paper in the rear path area (i), pull out any sheets
found in this area.

STEP 14 of 17

If the sheet is low down in this area and difficult to
remove, it is probably still gripped by the fuser. In
this case raise the top cover, reach around and
press down on the fuser pressure release lever (d).

Pull down the MP tray using the depressions. Lift the
front cover release lever and lower the front cover.
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STEP 15 of 17 STEP 16 of 17
=~ g ﬁ\

Check inside the cover for sheets in this area and
remove any that you find, and then close the cover.

Pull out the paper tray and ensure all paper is stacked
properly, is undamaged, and that the paper guides are
properly positioned against the edge of the paper
stack. When satisfied replace the tray. Close the top
cover and press down firmly so the cover latch closes.

| ] ]
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STEP 17 of 17

guide tray.

Pull out the paper guide tray, clear out any paper
jams. Reload fan fold paper and close the paper

The following table summarizes possible causes of paper jams and suggests ways of avoiding them.

POSSIBLE CAUSE

SUGGESTED REMEDY

The printer is not level.

Place the printer on a steady, level surface.

Your print media is too light or too heavy.

Use appropriate media

Your print media is damp or charged with static
electricity.

Use media that has been stored in appropriate temperature and
humidity conditions.

Your print media is creased or curled.

Use appropriate media. Decurled media can be used.

Your print media sheets are not aligned with each
other.

Remove the sheets, jog them into alignment and reload them.

Your print media is not aligned properly in the
paper tray.

Adjust the paper stop and paper guides of the tray, or the manual
feed guide on the MP Tray to align the media properly.

i
i i
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6.6 How to Print Configuration Information from the Printer

1. Press DOWN arrow, scroll to Print Information, press Enter.
2. Select Configuration, press Enter.
3. Select Execute. It will then start to print the page information.

6.7 How to Print a Secure Job from the Printer

STEP 1of 1

1. Press DOWN arrow, scroll to Print Secure Job, press Enter.
2. Select Stored Job, press Enter.
3. At this step, you have 4 passwords (0000,0001,0002,0003) for the different jobs.
e 0000 is for drum test
e 0001 is for color test
e 0002 is for die-cut test (you should use die-cut media for this job)
e 0003 is for calibration. (It is the same as Color Registration from the Software)

4. Press Enter after your key in the password.

5. Select Print.

4. Choose the amount of copies you want to print, and press Enter.
T
T i
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6.8 Sensor Calibration from the Feeder (For Die Cut Labels Only)

STEP 1 0f 11

-

\

ml_
T — e T — T2
— = )

Follow STEP 1-7 of "Loading Media for Continuous Printing" to load the roll. Place the roll of paper into the paper
tray. Feed the media through, ensuring it is underneath the tension and pinch rollers. With the media flush against
the back of the machine, ensure that there is no extra space on each side of the media and the left/right media
guides.

Close the left/right media guides. Ensure that the media is not buckling or too snug against the guide widths before
proceeding.

STEP 2 of 11
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Line up the gap of the labels about one inch below the sensor.

Cut the excess paper to make sure the top of paper is flush with the drive roller.

Backwind the roll to ensure there is no tension when the sensor is calibrating. If the roll is fully wound and has tension
on it, it will skew the calibration.

STEP 4 of 11
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Press the On Line button to take the feeder offline.

STEP 5 0of 11

Press Menu twice to get to M2: Calibrations.

STEP 6 of 11

Press the UP arrow button to get to I13: Reg Sensor. Hold down the Menu button until the * disappears.
Press Menu twice to get to the sensor type. Use the UP and/or DOWN buttons to set the Gap. Then hold Menu until
it stops flashing.

STEP 7 of 11
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Press the UP arrow to scroll to 14: RSEN AutoCal and hold Menu until Ready starts flashing.
Press the UP arrow to select Execute and hold Menu until it stops flashing.

STEP 8 of 11

Statys: Offline

Press Menu again and it will show Status: Offline.

STEP 9 of 11

Press the On Line button and the calibration test will begin. After the calibration is done, it will read Status: Require
Load.

STEP 10 of 11
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Statust Path Full

After the calibration process, press the On Line button to turn the machine Offline, and then hold the DOWN button
to cut the excess paper after the calibration is complete.

NOTE: If you press Load at this moment, the machine might show Path Full because of the excess paper.

STEP 11 of 11

Remove the paper. Press the On Line button again and select Load. Afteris, the machine will show Idle and is
ready to use now that the calibration is done.

STEP 11 of 11
[ Calibrate Sensors EE

Feeder Settings Media Library Settings
Sensor Type Gap Sensor Type Gap
Sensor Gain 147 Sensor Gain 100
Sensor Window 200 Sensor Window 150
Cpen File [ Copy Feeder Settings To Media Library J [ Copy Media Library Settings To Media Library

Sensor

[¥] Die Cut Mode:

) Back

Go the EDGE2Print software, click Calibrate and then click Copy Feeder Setting To Media Library to save the
setting. Or when you print, the values in the media library will overwrite the values in the feeder.
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6.9 How to Access the Settings as an Administrator

You can set whether to ENABLE or DISABLE each category in the user menu.
Disabled categories are not displayed in the User's menu. Only a system administrator can change these settings.

1.

© 00 N O O b~

Turn OFF the printer. Turn ON the printer while pressing the Enter button. When Boot Menu appears, take your
finger off the button.

. Press the Enter button.

. At the Enter Password prompt, enter the 4-9 digit Admin password. (The default password is aaaaaa).

(a) Using the up and down MENU buttons, scroll to the required letter/digit.
(b) Press the Enter button to input and move to the next letter/digit.

(c) Repeat steps (a) and (b) until all letters/digits are entered.

. Press the Enter button.

. Press the UP or DOWN arrow button until the “category” you want to change is displayed.
. Press the Enter button.

. Press the UP or DOWN arrow button until the “item” you want to change is displayed.

. Press the Enter button.

. Using the UP or DOWN arrow button, identify the parameter as required.

10. Press the Enter button to enter an asterisk (*) on the right side of the setting selected.

11. Press the Online button to switch to online. The machine will automatically re-boot.
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6.10Paper Sensor Error Codes
381 385

380

O

___-—o——-—‘____' |
10-11 -
I 2

—— =
Code # Location
380 Paper Feed Upper
381 Paper Transport
382 Paper Exit
385 Fuser
392 Paper Feed Lower
10-11 Load Sensors

Feeder Panel Error Messages:

Message Issue

Msg: Guide Door Open Ensure Guide Door is Closed
o Push Guide Tray Completely into the Feeder. Ensure
Msg: Guide Tray Out Guide Tray Latches are Locked.
Msg: Close Guide Tray Ensure Guide Door is Closed
Push Guide Tray Completely into the Feeder. Ensure
Guide Tray Latches are Locked.
Msg: Funnel Full Remove all Paper from the Guide.
Msg: Path Full Remove all Paper from the Guide.

Msg: Close Door/Tray
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Feeder Panel Errors:

Error Issue Solution

Status: Error 00 Emergency stop (guide door opened during | cjose Door on Feeder
motor movement)

Status: Error 01 Switch panel communication error Contact your dealer/reseller

Status: Error 02 Internal error Contact your dealer/reseller

Status: Error 03 Internal error Contact your dealer/reseller

Status: Error 10 Media not found over lower load sensor after | Do a sensor cz_:lllbratlon(p.57 in the manual) or
load remove paper in path

Status: Error 11 Media not positioned between load sensors Check that media tension is not too tight
properly after load advance

Status: Error 31 fiirl:]t;er did not leave home position in required Check paper jam in cutter

Status: Error 32 Cutter did not finish cut in required time or Check paper jam in cutter

can't home it
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